IN THE UNITED STATES DISTRICT COURT
FOR THE EASTERN DISTRICT OF TEXAS
MARSHALL DIVISION

SOLOCRON MEDIA, LLC,
Case No. 2:13-¢cv-1059-JRG

Plaintiff,
V.

VERIZON COMMUNICATIONS INC., CELLCO
PARTNERSHIP D/B/A VERIZON WIRELESS, [JURY TRIAL DEMANDED]
AT&T MOBILITY LLC, SPRINT SPECTRUM L.P.,
AND T-MOBILE USA, INC.,

Defendants.

DECLARATION OF ERIN FLAUCHER

I, Erin Flaucher, do hereby declare that I am over twenty-one years of age
and have personal knowledge of the facts declared herein:

1. I am a Paralegal employed by Microsoft Corporation (“Microsoft”)
located at One Microsoft Way, Redmond, WA 98052. I have been employed by
Microsoft since October 2009.

2. I make this declaration for the purpose of confirming the business
records of certain products and authenticating certain documents. The facts set
forth in this Declaration are based upon information provided to me. [ am
competent to testify to all matters stated, and if called upon to do so, I would
testify to the facts set forth in this Declaration.

3. To the best of my knowledge, the Nokia 9110 Communicator (“the
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9110 Product™) was introduced to the public on March 18, 1998 at the CeBIT ‘98
exhibition in Hannover, Germany. A true and correct copy of a press release dated

March 18, 1998 1s attached to this Declaration as Exhibit A.

4, The 9110 Product was first released to the public for sale in January
of 1999.
5. It is my understanding based upon information from the Microsoft

Mobile Oy Product Lifecycle Capability Organization, which maintains certain
records on products that as part of the release and sale of the 9110 Product, Nokia
created a parts package with the designation of 0069108. This 0069108 parts
package constituted items that were included in the box when a 9110 Product was
sold and included (among other items): a 9110 Product; a copy of a compact disc
(CD) with the parts code of 0840003; a copy of the English version of the User’s
Manual with the parts code of 9357168, a copy of the English version of the Quick
Guide with the parts code of 9357169. The 0069108 parts package was approved
to be added to the sales package by Nokia on January 26, 1998. On June 22, 1999,
the 9110 Quick Guide with a parts code of 9351912 was added to the parts package
0069108.

6. It is my understanding based upon information from the Microsoft
Mobile Oy Product Lifecycle Capability Organization, which maintains certain

records on products that Nokia created another parts package with the designation
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of 0069141 wversion 1.1 with a description of this package being “Nokia 9110
Communicator European 3 sales package, EN transceiver, EN user guide and quick
and accessory guide and Europlug.” This 0069141 version 1 parts package
constituted items that were included in the box when a 9110 Product was sold and
included (among other items): a 9110 Product; a copy of a compact disc (CD) with
the parts code of 0840003; a copy of the English version of the User’s Manual with
the parts code of 9357168, a copy of the English version of the Quick Guide with
the parts code of 9357169; and a copy of a disk with the parts code of 00840003.
The 0069141, version 1.1 parts package was released by Nokia on June 18, 1999.
Under Nokia’s standard business practices, the items in the 0069141, version 1.1
parts package would have been provided to purchasers of the 0069141 shortly after
the release date of the product and available to the public as of that date.

7. Exhibit B is a listing for the parts code 0840003 of files that were on
that CD when it was included in the packages above.

8. Exhibit C is a screenshot of the top level directory for the CD with

parts code 0840003 referenced above. For clarity, Exhibit C shows the following:

Name Date Modified Type Size
data 18.1.1999 File folder
9110 1.12.1998 Application 226 KB
9110 21.10.1997 Icon IKB

3
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autorun 14.11.1998 Setup Information 901 KB
OPENING 8.12.1998 BMP File 901 KB
README 17.11.1998 Text Document 13 KB
VSTART 11.1.1999 Configuration sett... | 1 KB
VSTART32 14.11.1998 Application 180 KB

9. Exhibit D is a copy of the cover for the CD with parts code 0840003
referenced above.

10.  Exhibit E is a sales report for the 9110 Product. Exhibit E is a true and
correct copy of the original report that was retrieved from Microsoft Mobile Oy’s
databases. = Microsoft Mobile Oy is an indirect subsidiary of Microsoft
Corporation. Exhibit E is a Microsoft Mobile Oy business record showing units
distributed to consumers for the 9110 Product sold in 1999.

11. Each sales package for the Nokia 9110 product in 1999 that the
Microsoft Mobile Oy Product Lifecycle Capability Organization has checked at
my request included CD 0840003 except for a sales package which was a
“replacement” package. Exhibit E shows sales for all parts packages that included
the 9110 product and includes sales of parts packages 0069108 and 0069141.

12.  Exhibit E accurately reflects the information kept by Microsoft
Mobile Oy in the regular course of business and was recorded at or near the time of

transactions by employees or representatives of the predecessor of Microsoft
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Mobile Oy (which was Nokia Corporation (“Nokia™)) with knowledge. It is the
regular practice of Microsoft Mobile Oy’s business to keep such records, and
current employees of Microsoft Mobile Oy who were formerly employees of the
predecessor Nokia Corporation confirmed that it was the regular practice of Nokia
Corporation’s business to keep such records.

13.  Issue 2 of the User’s Manual for the Product was included on the CD
with parts code 0840003. This User’s Manual 1is in the file
Data\DOCS\MANUALS\USERG\ug_en2.pdf as shown in Exhibit F. As noted on
its front cover, Issue 2 had the identification of “9357168” on its front cover. A
true and correct copy of this User’s Manual, as it was on the CD 0840003, is
attached to this Declaration as Exhibit F.

14. The CD 0840003 included a document entitled “Nokia 9110
Communicator WWW Browser Style Guide.” This Style Guide is in the file
Data\DOCS\CORP_USE\LM_ EN\ BROWSREN.PDF as shown in Exhibit G. A
true and correct copy of this Style Guide, as it was on the CD 0840003, is attached
to this Declaration as Exhibit G.

15.  The CD 0840003 also included a document entitled “PC Suite for
Nokia 9110 Communicator User’s Guide.” This PC Suite User’s Guide is in the
file Data\ADOCS\PCGUIDES\Suite en.PDF as shown in Exhibit H. A true and

correct copy of this PC Suite User’s Guide, as it was on the CD 0840003, is
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attached to this Declaration as Exhibit H.

16.

The CD 0840003 also included two directories that contained files

with an extension of .\WAV. These directories were Data\WAVSOUND\ and

Data\9110_SWASOUNDS\ as shown in Exhibit B.

I declare under penalty of perjury under the laws of the United States of

America that the foregoing is true and correct.

November 2014, in the United States of America.

“@q{;ﬂu\/’\.ﬂ/

Erin Flaucher

List of Exhibits:

Exhibit A March 18, 1998 Press Release on 9110 Product

Exhibit B List of files on CD for parts code 0840003

Exhibit C  screenshot of the directory for 0840003 CD

Exhibit D Cover for CD 0840003

ExhibitE  sales report for the 9110 product

Exhibit F 9110 User’s Manual Issue 2 on CD 0840003

Exhibit G Nokia 9110 Communicator WWW Browser Style Guide on CD
0840003

ExhibitH  PC Suite for Nokia 9110 Communicator User’s Guide on CD

0840003

Executed on the  day of
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11/11/2014 Nokia introduces its second generation communicator -The pocket-sized Nokia 9110 Communicator combines an ultimate mobile office with a superb ...

To enhance the functionality and usability with PCs, Nokia has included in the sales package a
new software, the PC Suite for Nokia 9110 Communicator. This software allows the user to
transfer information and software between the ccmmunicator and computers using
Windows 95 and Windows NT 4.0 operating systems.

The need to access data on the move has been one of the key drivers for the industry in
creating data communication solutions. As wireless services have evolved beyond voice,
value-added services play an increasingly important role not only in business use but also
personal lifestyle uses with the emergence of electronic banking and commerce, electronic
postcards and infotainment, for example.

"Nokia's goal is to offer value-added services through compact, user-friendly devices that
are not technologically intimidating. The new Nokia 9110 Communicator has an easy-to-use
design, but features revolutionary applications such as wireless imaging; this shows that
wireless multimedia is not about the future but about today,” notes Mr Vanjoki.

Wireless imaging and memory extension capabilities

First in the world, the Nokia 9110 Communicator enables wireless image sending and
receiving. With the application called Digital Camera Connectivity, the user can receive
pictures via infrared from digital cameras which support the Ir-TranP protocol. Photographs
can be sent over the air for further processing. Pictures can also be attached to mail or fax
sending.

As another industry first, Nokia has selected the Memory Card for extending user data
memory in the Nokia 9110 Communicator. The Memory Card, about the size of a postage
stamp, is the world's smallest removable data storage card providing memory up to 4 MB.

http://company .nokia.com/en/news/press-releases/1998/03/18/nokia-introduces-its-second-generation-communicator-the-pocket-sized-nokia-9110-communic...  2/4
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11/11/2014 Nokia introduces its second generation communicator -The pocket-sized Nokia 9110 Communicator combines an ultimate mobile office with a superb ...
The Nckia 9110 Communicator will be able to store audio, travel guides, dicticnaries, still
images, software, large directories and documents in the MultiMediaCard. The card,
developed by SanDisk and Siemens, will be sold as a standard Nokia accessory.

Superb mobile phone

The phone user interface of the Nokia 9110 Communicator is based on the Nokia 6100
series, making the communicator a phone with the latest features, outstanding audio and
speech quality and excellent operating times. The phone provides up to 6 hours of talk time
and the stand by time is up to 200 hours (8 days). With the 'profile’ function, the user can
adjust the phone settings according various situations from meeting to outdoor mode.

The Nokia 9110 Communicator has a 486 based AMD embedded processor and a GEOS 3.0
operating system platform. The product is ready for data speed of 14.4 kbit/s, and supports
several standard e-mail protocols. A total of 12 language versions are available.

As the industry leader in wireless data, Nokia established a totally new product category by
introducing the first Nokia 9000 Communicator already two years ago. At present, the Nokia

Communicators are sold in over 30 markets worldwide.

Headquartered in Finland, Nokia is a broad-scope telecommunications company supplying
mobile phones, mobile and fixed telecommunications networks, data communications
solutions, multimedia terminals and PC monitors. With sales in 130 countries, net sales
totaled FIM 52.6 billion ($9.8 billion) in 1997. Nokia employs more than 36,000 people
worldwide.

http://company .nokia.com/en/news/press-releases/1998/03/18/nokia-introduces-its-second-generation-communicator-the-pocket-sized-nokia-9110-communic...  3/4
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Curtype: EUR (PVA)
Views: Periodic
Accounts: Volume Sold
Names: Regions Total
1998 1999 1999 1999 1999 1999 1999 1999 1999 1999
Period 1 Period 1 Period 2 Period 3 Period 4 Period 5 Period € Period 7 Period 8 Period 9
1AHO Communicator - GSM300 - Spock - DCT3 - 9110 330.00 13,449.00  22,460.00  34,780.00  23,908.00  29,976.00  27,309.00  21,241.00  20,727.00
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1999 1999 1999 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000 2000
Pericd 10 Period 11 Pericd 12 Period 1 Pericd 2 Period 3 Pericd 4 Period 5 Pericd 6 Period 7 Pericd 8 Period © Pericd 10 Period 11
23,546.00 27,366.00 28,066.00 14,665.00 12,032.00 16,150.00 20,302.00 15,737.00 14,101.00 12,446.00 14,310.00 18,404.00 18,643.00 14,248.00
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2000 2001 2001 2001 2001 2001 2001 2001 2001 2001 2001 2001 2001 2002
Pericd 12 Period 1 Period 2 Period 3 Pericd 4 Period 5 Pericd 6 Period 7 Pericd 8 Period 9 Pericd 10 Period 11 Pericd 12 Period 1
19,031.00 16,756.00 8,392.00 1,436.00 1,344.00 394.00 16,00 -47.00 -52.00 13.00 23.00 2.00 0.00 23.00
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2002
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2002
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2002
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2002
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User's manual

9357168
ISSUE 2 EN
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END USER LICENSE AGREEMENT FOR SECURITY SOCKETS LAYER -SOFTWARE ("SSL")

READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY BEFORE USING THE SSL. USE OF THE SSL SOFTWARE
INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.

In this license agreement ("License Agreement”), you, the purchaser of the license rights granted by this Agreement,
are referred to as "Licensee.” In accordance with the terms and conditions of this License Agreement, Nokia Mobile
Phones Ltd. ("Licensor") grants Licensee a non-exclusive sublicense to use SSL Software (“Software"), which contains
the RSA Software licensed to Licensor by RSA Data Security, Inc. ("RSA”).

This License Agreement is effective until terminated. Licensor may terminate this License Agreement if Licensee
breaches any of the terms and conditions. In the event of termination by Licensor, Licensee will return the
communicator device of Licensor to Licensee for removal of the Software. All provisions of this Agreement relating
to disclaimers of warranties, limitation of liability, remedies, or damages, and Licensor's proprietary rights shall
survive termination.

The Software is delivered in object code only.

Licensor shall utilize the Software solely as part of the communicator device from Licensor and solely for personal
or internal use and without right to license, assign or otherwise transfer such Software to any other person or entity.
Licensee shall not modify, translate, reverse engineer, decompile or disassemble the Software or any part thereof.
Licensee agrees not to remove or destroy any proprietary, trademark or copyright markings or notices placed upon
or contained within the Software or any related materials or documentation.

By reason of this Agreement or the performance hereof, Licensee shall acquire no rights of any kind in any trademark,
trade name, logo or product designation under which the Software was or is marketed and Licensee shall not make
any use of the same for any reason.

IN NO EVENT WILL LICENSOR OR RSA BE LIABLE TO LICENSEE FOR INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL
OR EXEMPLARY DAMAGES ARISING OUT OF OR RELATED TO THIS AGREEMENT, INCLUDING BUT NOT LIMITED TO
LOST PROFITS, BUSINESS INTERRUPTION OR LOSS OF BUSINESS INFORMATION, EVEN IF SUCH PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF WHETHER ANY ACTION OR CLAIM IS BASED
ON WARRANTY, CONTRACT, TORT OR OTHERWISE. UNDER NO CIRCUMSTANCES SHALL LICENSOR'S OR RSA'S TOTAL
LIABILITY ARISING OUT OF OR RELATED TO THIS AGREEMENT EXCEED THE TOTAL AMOUNT PAID BY LICENSEE.
THIS AGREEMENT IS EXPRESSLY MADE SUBJECT TO ANY LAWS, REGULATIONS, ORDERS OR OTHER RESTRICTIONS
ON THE EXPORT FROM THE UNITED STATES OF AMERICA OF THE SOFTWARE OR OF INFORMATION ABOUT THE
SOFTWARE WHICH MAY BE IMPOSED FROM TIME TO TIME BY THE GOVERNMENT OF THE UNITED STATES OF
AMERICA. NOTWITHSTANDING ANYTHING CONTAINED IN THIS AGREEMENT TO THE CONTRARY, LICENSEE SHALL
NOT EXPORT OR REEXPORT, DIRECTLY OR INDIRECTLY, ANY SOFTWARE OR INFORMATION PERTAINING THERETO TO
ANY COUNTRY TO WHICH SUCH EXPORT OR REEXPORT IS RESTRICTED OR PROHIBITED, OR AS TO WHICH SUCH
GOVERNMENT OR ANY AGENCY THEREOF REQUIRES AN EXPORT LICENSE OR OTHER GOVERNMENTAL APPROVAL AT
THE TIME OF EXPORT OR REEXPORT WITHOUT FIRST OBTAINING SUCH LICENSE OR APPROVAL.

Verizon Wireless
Exhibit 1082-0048



Verizon Wireless
Exhibit 1082-0049






Table of contents

Table of contents

Table of contents 6

Introduction 1
About this manual 2
Facts about your communicator 3
Facts about cellular data transmission 4

7

Getting started
First start-up 7
Communicator display 10
Communicator keyboard 14
Communicator applications 15
Connectors 16
Battery 17
Special features 21
Communicator features 21
Document features 24
To transfer data from older communicator models 27
PC connectivity 29
To use the PCSuite 29
To use the Nokia Communicator Server 36
Contacts 39
Contacts directory 39
To make contact cards 41
Contact groups 44
Logs 45
Telephone 47
To make a call 47
To answer a call 48

Verizon Wireless
Exhibit 1082-0051



Handsfree mode 49 £

Multiple calls 50 5

Telephone settings 53 5

Flight profile 57 3
Fax 59

To send faxes 59

To receive faxes 61

Fax settings 62
Short messages 65

To send short messages 66

To receive messages 67

Standard messages 68

Business cards 69

SMS settings 70
Internet 73

Internet settings 74

Mail 77

Mail settings 77

To send mail 80

To fetch mail 82

To read mail 83

World Wide Web 85

WWW settings 85

Bookmarks 86

To navigate in WWW 89

Terminal 92

Telnet 95

Text Web 97
Notes 99

To edit documents 101

Downloaded files and read-only documents 102

Notes settings 103

Verizon Wireless
Exhibit 1082-0052



Table of contents

Calendar 105

Monthly schedule 105
Weekly schedule 106
Daily schedule 107
Calendar booking 109
Alarms 111
To-do list 111
System 113
System settings 113
Security 115
User data 118
Memory 118
Infrared activation 119
Digital camera connectivity 119
Remote synchronisation 120
Fax modem 121
Data removal 122
Install/Remove software 122
Backup/Restore 123
Memory card tool 123
About this product 123
Extras 125
Calculator 125
Clock 126
Composer 129
Voice recorder 132
Phone 135
Display indicators 136
To make a call 137
Toanswera call 138
To manage calls 138
To search for phone numbers 139
To use speed dialling 139
To send DTMF tones 140

Verizon Wireless
Exhibit 1082-0053



Keypad lock

Help

To use the menus
Messages (Menu 1)
Call register (Menu 2)
Profiles (Menu 3)
Settings (Menu 4)
Call divert (Menu 5)
Recorder (Menu 6)

Troubleshooting

Care and maintenance
Important safety information
Glossary

Index

140
141
141
143
144
146
147
151
152

153
159
161
165
169

Table of contents

Verizon Wireless
Exhibit 1082-0054



Verizon Wireless
Exhibit 1082-0055












S

Introduction

Contactinformation

All contact information, such as names, addresses, phone numbers, that you
store, goes into the Contacts directory. The phone, the communicator
interface, and each of the applications have their own views of the Contacts
directory. The information shown depends on the information the selected
application can use. For example, when you are making a call via the phone,
you can view the name and the phone number(s) of the contact. Possible fax
numbers, e-mail addresses, job titles, etc., are not shown.

Facts about cellular data transmission

The Nokia 9110 Communicator employs the data transmission capabilities of
the GSM network to send faxes, short messages and e-mail, and to establish
connections with remote computers.

Cellular data connections can be made from most locations where your
wireless phone operates. However, it is recommended that you move the
communicator to a location where the strongest possible cellular signal can
be obtained. When the signal is strong, data transmission is efficient. In
general, you should not expect the same performance from cellular data
communications as from landline communications due to the inherent
characteristics of the cellular environment. The following factors may impair
cellular connections:

Noise

Radio interference from electronic appliances and equipment, as well as from
other wireless phones in metropolitan areas where wireless phones are
prevalent.

Handover

As the wireless phone user moves from one network cell to another, the signal
strength of the channel drops and the cellular telephone exchange may hand
the user over to a different cell and frequency, where the signal is stronger. A
cell handover may also occur when the user is stationary due to varying
cellular traffic loads. Such handovers may cause slight delays.

Electrostatic discharge

A discharge of static electricity from a finger or a conductor may cause
erroneous functions in electric devices. The discharge may result in "garbled”
display and unstable software operation. Cellular connections may become
unreliable, data may be corrupted, and the transmission halted. In this case
you need to end the existing call (if any), switch off the phone (if on) and
remove the battery. Then replace the battery and establish a new cellular
connection.
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characters. Some special characters are also printed on a key as the third
character. These, and certain other characters can be generated by pressing
and holding the character key while pressing the corresponding key, see "To
edit documents" on page 101.

® Control (Ctrl)

Pressed together with certain keyboard keys, the control key generates
shortcut commands which can be used in viewing and writing text, see
"Document features” on page 24.

® and @ Shift

When you press the Shift key and then a letter key, an uppercase letter is
inserted in front of the cursor. The Shift key does not need to be held down
when pressing a key: once you have pressed Shift, the next key press always
generates a shifted character. In writing and editing text, Shift and the arrow
keys (@) can be used to select text, see "Document features” on page 24.

Arrow keys

The arrow keys can be used to move the cursor or the selection frame. In some
applications, the arrow keys have special functions, see "Document features”
on page 24.

® Enter

When the cursor is shown, pressing Enter moves the cursor to the beginning
of the next line or adds a new line. Enter can also be used to select contacts in
the Contacts directory and to open folders and documents. When information
notes are shown, you may press Enter instead of OK. In options and settings,
when avalue can be toggled, you may press Enter instead of Change.

Getting started ¢;

Communicator applications

The coloured application buttons on the communicator keyboard are used to
start the corresponding applications.
Telephone — Used for managing voice calls.

Fax — Enables you to send any of your own documents as a fax. Received
faxes can be read or forwarded.

SMS — Enables you to send short messages. Received short messages can be
read, replied, or forwarded.

Internet — Includes Internet and modem-based applications.

Contacts — Used for managing contact information, such as names, numbers
and addresses. You can exchange contact information as business cards via
the SMS application.

Notes — Used for writing and storing documents.
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Special features

Document features

To name a document

Every time you close a new document for the first time, you will be asked to
enter a name for the document in the input field. The highlighted name in the
input field is the communicator's suggestion for the name.

To use shortcuts

There are several shortcuts you can use in the document applications. The
following table lists the available shortcuts:

Shorteut Function

Ctrl-A Selects all

Ctrl-C Copies selected text

Ctrl-X Cuts selected text

Ctrl-V Pastes selected text

Ctrl-Z Cancels the most recent operation
Ctrl-B Applies bold

Ctrl-| Applies italics

Ctrl-U Applies underlining

Ctrl-T Adds current time

Ctrl-D Adds current date

Ctrl-M Adds user's name

Ctrl-H Moves the cursor to the beginning or the end of the
Ctrl-E document

Ctrl-N Opens the next item

Ctrl-P Opens the previous item

Chr-left or right arrow Moves the cursor to the beginning or end of the line

Chr-up or down arrow Scrolls the list or document view up or down

Shift-Ctrl-left or right Selects the previous or the next word

arrow
Shift-right/left/up/ While Shift is held down, each press of an arrow key
down arrow selects one text character or line

Shift-Chr-up or down

arrow Selects text page by page inside a document
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Special features

To transfer data between different language versions

1

If the languages are not compatible, e.g. if you want to transfer data from
a Finnish version of the Nokia 9000i Communicator to a French version of
the Nokia 9110 Communicator, move your contacts and calendar data
with the Nokia Communicator Server program onto a PC using the Import/
Export contacts and Import/Export calendar data applications.

Move your documents with the Nokia Communicator Server program onto
a PCusing the File transfer application.

Start the PC Suite for Nokia 9110 Communicator program on the PC and
transfer the contacts, calendar data, and documents to the Nokia 9110
Communicator.
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Contacts

The Contacts function of the PC Suite lets you create, edit and update contact
cards on your Nokia 9110 Communicator, and transfer them between a PC
and your communicator. To start the Contacts application, click on the
Contacts icon in the main screen.

PC connectivity

Figure 2

Intellisync

With the Intellisync function you can synchronise data between your
communicator and a PC.

1 Connect your communicator to the PC.

2 Start the PC Suite program on the PC and click the Intellisync icon in the
main screen.

3 The Local (i.e. PC) tab is automatically selected. Click the Settings button.
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PCconnectivity

2 Start the PC Suite program on the PC and click the File Transfer icon in the
main screen.

3 Select an item by clicking on it in the File Transfer screen with the mouse
and drag and drop it to the appropriate PC directory or communicator
folder.

Backup / Restore

Figure 4

The Backup/Restore function enables you to create backups of your
communicator data on a PC and later restore the data in the communicator.

1 Establish a connection between your communicator and a PC, see above.

2 Start the PC Suite program on the PC and click the Backup/Restore icon in
the main screen.
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Contacts

To access the logs
1 Press the Menu button in the Contacts directory.

2 Select either Individual log or General log.
To erase the contents of the log
1 Press Clear list.

2 A pop-up box opens to let you define how old communications you want
to remove. The clearing procedure reflects on the other log as well.

To make a new contact card
1 Open the General log.

2 Selectalog event and press Create card. If the contact card already exists,
the command is dimmed.

To view only certain communication types
1 Open the General log and press Filter.

2 Select the communication type you want to view and press OK.
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Telephone

Pager — You can set this profile on, when you want the communicator to
act as a pager, i.e. the ringing tone is silent and only received SMS
messages alert.

Flight — Sets on the flight profile, see "Flight profile” on page 57.

Car — The car profile is set on automatically when the communicator is
connected to a car kit.

Headset — The headset profile is set on automatically when a headset is
connected to the communicator.

Press Rename to change the names of the profiles.

Press Edit to modify the following features of a profile:

All alert tones — You can set the incoming call alert and other alarms to:

Ringing — The normal alert tone is used.

Ascending — The normal alert tone is used, but the volume of the tone
increases gradually.

Ring once —The alert tone sounds only once.
Beep once — A single beep is heard when you receive a call or a message.

Caller groups — The alert tone will only sound when you receive a call from
a member of the selected caller group. See below.

Silent — All the sounds, except the alarm clock, are turned off.
Whatever the chosen setting, an incoming call is always indicated by a note.
Ringing volume — Adjusts the ringing volume: 7 is the lowest, 5 the highest.

Ringing tone — Determines the ringing tone. To compose your own ringing
tones, see "Composer” on page 129, and to record a ringing tone with the
Digital voice recorder, see "Voice recorder” on page 132.

Communicator key click — Sets the communicator keyboard sound to Off,
Type 1 or Type 2.

Phone key click — Adjusts the phone keypad sound: 7 is the lowest, 3 the
highest, Off turns off the keypad sound.

Divert all voice calls —You can divert all your incoming voice calls to another
phone number. The option Default diverts uses the diverts set in the Network
settings. See below.

Phone lights — The phone display and keypad lights are either permanently on,
or they remain on for the pre-set time period. Available in the car profile only.

Automatic answer — All calls are automatically answered. Available in the car
profile only.

Caller groups — Set one or several contact groups to Yes, and only those
messages, calls, faxes etc. that come from people belonging to these groups,
alert.
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Call settings

Own number sending — You can select whether to keep your phone number
hidden from the recipients of your phone calls. Do not use this function unless
it has been activated for your SIM card.

Telephone

On — Your number is shown to all the recipients of your calls.
Off — Your number is hidden from all the recipients of your calls.
Preset — The value stored in the network is used.

Next on — Your number is shown to the recipient of your next call.

Next off — Your number is hidden from the recipient of your next call.

Call cost settings — You can set on the call cost counter and modify its
settings. Changing the settings requires the PIN2 code.

Audio when cover opened — Determines whether the handsfree mode is set on
automatically after you open the cover.

Call timer display — If set to On, the call timer is shown during calls.

Automatic redialling — When this function is set on and you call a number
that is busy or does not answer, the communicator will attempt to call the
number until the call is connected.

Phone line in use — If your network and SIM card support this feature, you can
have two different subscriptions for voice calls. These subscriptions are
referred to as Line 1 and Line 2. Each line may have separate settings for some
functions. With this setting, you can determine which phone line is currently
in use for all outgoing calls.

Default call mode — In some networks you have the same phone number for
all your voice, fax and data calls. If you want to receive any calls, you must set
your phone to some answering mode. The available modes are Voice, Fax, Data
and Voice/Fax.

Network settings

The network services may not be supported by all operators, or you may have
to subscribe to them.

Information about the status of these services is stored in the network.
Therefore, the current settings are not shown until you request the
information from the network by pressing Get status.

While the communicator is making a request to the network, a query note is
shown on the display. After a successful request, the new status now appears
in the settings list.

To cancel all call diverts or barrings, press Cancel call diverts or Cancel call
barrings.

Voice call diverting — This network service allows you to direct your incoming
voice calls to another phone number.
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Separate page — Only the cover page contents are shown on the first page
of the fax.

Fax

None — No cover page information will be attached to the fax. The first
page of the document will be the first page of the fax.

Begin sending — Lets you choose when the fax is sent:
Immediately — The fax is sent right away.

At [time] — You can determine the time when the fax is sent. Use the time
format hh:mm. This option enables you to take advantage of cheaper
calling times.

Receive resolution:

Standard — The fax will be received using 200 (width) x 100 (height) dots
per inch (dpi) resolution.

Fine — (200 x 200 dpi). Receiving faxes with fine resolution will take longer
and requires approximately twice as much memory as with standard
resolution.

Send resolution:
Standard — 200 x 100 dpi.

Fine— (200 x 200 dpi). Sending faxes with fine resolution takes longer and
temporarily requires more free memory than when using standard
resolution.

Logo file — Enables you to add for example the logo of your company to the
fax cover page. The logo file must first be stored in the GIF or JPG format in
the Downloaded files folder. The logo is not shown on the display.

No image — No logo is attached to the fax.

[File name] — All the available files in the Downloaded files folder are listed
in the pop-up box. Select the one you want to attach to the fax.

Signature file — Allows you to add your signature to the fax cover page. The
signature file must first be stored in GIF or JPG format in the Downloaded files
folder. The signature is placed under the Remarks field, but not shown on the
display.

No image — No signature is attached to the fax.

[File name] — All the available files in the Downloaded files folder are listed
in the pop-up box. Select the one you want to attach to the fax.

Fax call barring — This network service allows you to place restrictions on
outgoing and incoming faxes.

Fax call diverting — This network service allows you to divert incoming faxes
to another fax machine. For more information and instructions on how to
change diverting and barring settings, see "Telephone settings" on page 53.
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and unread received business cards with [E=]. Select the message and
press Open.

To reply to a received message
1 Select the Received messages folder and press Open.

2 Open the selected document and press Reply. The contents of the received
message are not included in the new message automatically. If you want
to include them, press the Menu button and choose the Reply (include
text) option.

3 Write the message and press Send.
To forward a received message
1 Select the Received messages folder and press Open.

2 Open the selected document, press Forward. The contents of the received
message are included in the new message.

3 Press Recipient and select a recipient from the SMS directory.
4 To send the message, press Send.

To use the Menu button

When you press the Menu button in an opened received message, you can also
use the following options:

Find number — If the message contains phone numbers, press Next number
to toggle between these numbers and to select one of them. Press Call to
make a phone call to the number.

Reply (include text) - Replies to a SMS message and includes the received SMS
inyour reply.

Find URL — If the message contains URL addresses, press Next URL to toggle
between these addresses and to select one of them. Press Fetch to start the
WWW application and to open a connection to the selected address.

Print — Prints the message.

Service cards

A DTMF service provider may send DTMF sequences to its subscribers in the
form of a service card that can be stored in the Contacts directory. For more
information on DTMF tones, see "To send DTMF tones" on page 140.

Standard messages

You can store frequently used short messages as standard messages, and send
them instead of writing a new message every time. Standard messages are
stored in the Standard messages folder.

To write a new standard message, open the Standard messages folder and
press Write message. The commands in a new standard message are:
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has a Nokia 9110 Communicator or a Nokia 9000i Communicator, the
messages are received as one long message.

SMS

Receive info messages: Yes/No/Miew index — If your network supports this
feature, it will send you information about various topics. If you choose View
index, the network will send you a list of topics, and you can select those
topics on which you wish to receive information.

Info service mode: Display and save/ Display only/Save only — If this is set to
Display and save, messages are displayed and saved in the Info messages
folder. If you select Save only, info messages are not displayed but saved in
the folder. If you select Display only, messages are displayed but not saved.

Info service language — You can select in which languages you want to
receive info messages. Select either A//, or a maximum of four languages.

Info service topics — Message topics vary according to the operator. You can
define here what type of messages you want to receive. For more information
about the Info service, contact your service provider.
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Receiving settings — Press Change to define the settings of the mail
messages you receive to this mailbox. Your remote mailbox service
provider will supply you with the required information. The settings are:

Internet

User name and Password — These may be required to connect to the
server and to open your mailbox.

The password characters appear as asterisks (*) on the display. The user
name and password stored here will automatically be offered to the
server. If you enter your user name and password incorrectly, you will be
prompted to enter them again when you connect to the Remote mailbox.
If you enter your user name and password incorrectly three times, the
connection to the Remote mailbox will end. For information on how to
change the password, contact your remote mailbox service provider.

Receiving host — The IP address or host name of the computer that
receives your e-mail.

Folder — INBOX is the default folder for your incoming mail. Do not
change this setting without consulting your remote mailbox service
provider. This setting is only available when the mail protocol is IMAP4.

Protocol: IMAP4 / POP3 — Choose the mail protocol your remote
mailbox service provider recommends.

Fetch headers: All / Recent — Determines whether all mail or just the mail
received since the last connection will be shown in the Remote mailbox.
It is possible to have old or unread mail in the Remote mailbox.

Fetch attachments: Yes / No — Determines whether possible mail
attachments are fetched or not. This option is only available if the mail
protocol is IMAP4. Note that text attachments are always fetched.

Delete fetched: Yes / No — Determines whether fetched mail will be
automatically removed from the Remote mailbox. All fetched mail goes
to the Received mail folder.

Timed fetching settings — With this setting you can set your communicator
to fetch mail automatically.

Timed fetching: On/Off — Determines whether the timed fetching
function is in use or not.

Start at: Date and Time — You can specify the date and time when the
communicator starts to fetch your mail. Use the date and time formats
specified in the System settings.

Time limit: None/5/10/30/60 min — You can set the time limit for the
fetching operation. This way your communicator will not fetch too
large messages, which would take too much time.
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To remove a mail message

1 Set the Delete fetched setting to Yes in the Mail settings. All fetched
messages are removed from the Remote mailbox. Or,

Internet

2 Select the message(s) you want to remove with the selection frame, and
press Delete. If you want to cancel the removing, press Undelete.

The messages will be removed when you exit the Remote mailbox. However,
all fetched messages will be retained in the Received mail folder.

To use the Menu button

If you press the Menu button in the Remote mailbox, the following options
become available:

Change folder — Opens another mail folder.

Create folder — Creates a new folder.

Copy — Copies the selected mail message(s) to another folder.

Move — Moves the selected mail message(s) to another folder.

Remove folder — Removes the selected folder and its contents and subfolders.
Rename folder — Gives the folder a new name.

Off-line — Ends the data call.

On-line — Re-establishes the data call.

To disconnect from the Remote mailbox

1 Press Hang up.

2 If you have messages marked as deleted, you will be prompted to confirm
the deletion.

3 The connection to the Remote mailbox closes, and the Mail application
main view returns to the display. If you have fetched messages, the
Received mail folder opens on the display.

Toread mail

Mail that you fetch from your Remote mailbox is stored in the Received mail

folder.

To read a mail message

1 Select the Received mail folder in the Mail main view and press Open. Mail
messages that have not yet been opened in the communicator are marked
with =.

2 Select the message, and press Open.

When you open a received mail, the following commands become available:

Attachments — Lists all MIME attachments: text, image, audio, video or
application. If the message does not contain any attachments, this command
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World Wide Web

The Nokia 9110 Communicator supports HTML 3.2, with the exception of
some features. SSL, the security protocol, is also supported. See “Glossary” on
page 167. The WWW browser does not support Java or Java script.

Internet

To connect to the World Wide Web, the Internet service must be activated for
your SIM card, and you need an account with an Internet service provider.

To open the World Wide Web application, select WWW in the Internet main
view, and press Select.

To exit the WWW, press Close or Hang up in the Bookmarks list, which is the
main view of the application. This ends the data call and closes the WWW
application.

For information on how to create tailored WWW pages for the Nokia 9110
Communicator, see the documents on the CD-ROM.

WWW settings

To change the WWW settings:
1 Open the WWW application and press the Menu button.

2 Select Settings.
3 Tochange a setting, select it and press Change.
The WWW settings are:

Autoload images: Yes / No — If set to Yes, the communicator automatically
fetches the inline JPG or GIF images on a WWW page. When set to No, WAW
pages are fetched without images and shown much faster.

Clear cache on exit: Yes / No — Most recently fetched WWW pages are kept in
the temporary memory of the communicator, the “cache". If set to Yes, the
cache, history list and cookie file are automatically emptied after you close
the WWW application. If set to No, the cache stores as much information as
possible. When you restart the WWW application, the most recently stored
information is fetched from the cache without making a new data call.

Accept all cookies: Yes /No — Determines whether the cookies functionality is
enabled. See "Glossary" on page 167.

Default access point — Defines the Internet access point used as a default in
the WWW application.

Proxies — To change the proxy settings, press Change.

Internet access point — You can select an |AP to be used for this particular
WWW page.

HTIP proxy— The hostname of the HTTP proxy server used with the selected IAP.
HTIP proxy port — The proxy port of the proxy server.
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To set advanced bookmark properties

Internet

Select Details and press Change. The advanced settings are:

User name — If a user name is needed to fetch the bookmark, enter your user
name here.

Password — If a password is needed to fetch the bookmark, enter your
password here.

Internet access selection: Automatic/Manual — If you select Automatic, the
current or the default IAP is used for this bookmark. If you set this to Manual,
only the IAP defined in the following setting is used.

Internet access — This setting is available only if the previous setting is set to
Manual. You can select which IAP to use for the bookmark.

To fetch items with a page already open

You can fetch a WWW page even if you have a page already open:

1 Press the Menu button and select Bookmarks. A simplified form of the
Bookmarks list opens.

2 Select an entry in the Bookmarks list or enter the URL in the address field.
3 Press Go.
To close the Bookmarks list, press Close.

To use the Menu button

If you press the Menu button in the Bookmarks list, the following options
become available:

History —Contains a list of browsed documents. To fetch a page from the list,
select the page and press Go. To empty the history list and the cache, press
Clear history.

Find —You can search for names and addresses in the Bookmarks list.

Open file —You can open files from the Own texts and Downloaded files folders.
Move — You can move the selected bookmark from one folder to another.
Delete — Removes the selected bookmark or bookmark folder.

Create folder — Creates a new bookmark folder.

Import bookmarks — Imports a bookmark file from the Own texts or
Downloaded files folder to the Bookmarks list.

Export bookmarks — Converts the bookmark file to the HTML format and saves
it to the Own texts folder.

Clear cache — Empties all caches and temporary files.
Settings — Opens the WWW settings. See "WWW settings" on page 85.
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Internet

Terminal connection

When you have connected to the remote system, the following commands
become available:

Press Keys to emulate the VT100 special keys, which are not available on the
communicator keyboard. The special keys include:

Four function keys: PF1-4. The specific function of these keys depends on
the service or program to which you are connected.

All VT100 application keypad keys: numbers 1-9, hyphen, comma, period,
enter.

The following VT100 functions: reset terminal, Ctrl-\, Ctrl-], Ctrl-~, Ctrl-2.

The selected special character is entered to the left of the cursor by pressing
Insert.

The arrow keys can be used for scrolling the view. Scrolling does not affect the
cursor position. Pressing any keyboard key returns the view to the cursor
position.

Press Hang up to close the connection to the host, end the data call and
return to the Terminal main view.

To transfer text

The purpose of the text transfer function is to enable you to send text from
the communicator to the host computer, or to copy text from the host
computer to the communicator. This function can be used, for example, to
send pre-written mail messages to the company mainframe computer, or
alternatively, copy received mail and then read it later, off line.

To send text to the host computer

1 Press Send text.

2 Open one of the folders shown and select the document you want to send.
3 Press Send. If you want to stop the sending procedure, press Stop sending.
While the text is being sent, the keyboard is inactive.

To copy text from the host computer
1 Prepare the text reading application on the host.

2 Press Capture text. All interaction with the host will be recorded in a file
in the Downloaded files folder. Control characters, except line changes,
will not be stored.

Press Stop capture to end the text capture process.
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Text Web

With Text Web you can fetch information from the Internet, using SMS. Such
information can include for example flight schedules, weather reports and
stock news. You can also access services provided by your network operator
and Nokia.

Internet

Nokia services

The contents are maintained by Nokia, and they cannot be changed. Nokia
updates the contents from time to time.

Operator services

The Operator services allows the network operator to provide various services
to the subscribers. The operator-specific items may vary from subscriber to
subscriber, and can be updated by the network operator.

To define services

1 To define new service access points, press Settings in the Text Web main
view.

2 Press New to open an empty service information card, or press Edit to
modify an existing service. Enter the title of the service, the server number,
which is a message centre number, and the service number, which is a
phone number.

To fetch information

1 In the Text Web main view, scroll to one of the service access points that
you have defined and press Select.

2 Enter in the space provided a keyword that describes the type of
information you are looking for. If you press Get keywords, you will
receive a list of available keywords. History list contains keywords that
you have used previously.

3 To send the keyword, press Send. When you receive a reply from the
service provider, the TTML browser opens up.

To use the browser
Press the arrow keys on the keyboard to move from one hotspot to another.

To follow a hyperlink, press Fetch. With Change you can tick off boxes and
buttons.

To add the form to the Saved forms list, press Save and select Save form. To
copy the text to the Downloaded files folder, select Copy text.
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To insert special characters from the keyboard

1 Press and hold the Chr key and simultaneously press a key with a special
character printed on the key as the third character. The special key will be
inserted on the display.

Notes

In addition, special characters can be generated using certain unmarked keys,

for example, "a" and "e":

1 Press and hold the Chr key and simultaneously press a letter key. The first
special character is displayed.

2 Continue to hold down the Chr key and press the letter key again. The
second special character is shown in the place of the first, and so on, until
the first character is shown again. The case of the special character is
determined by whether Shift or the Caps lock key has been pressed.

To send documents

When you press Send in the Notes editor, the following options become
available:

Send as fax — You can send the document as a fax. This option opens the fax
directory. The sending procedure from this point on is similar to that described
in "To send faxes" on page 59.

Send as short message — You can send the document as a short message. The
sending procedure is similar to that described in "To send short messages” on
page 66.

Send as mail —You can send the document as an e-mail message. The sending
procedure is similar to that described in "To send mail” on page 80.

Downloaded files and read-only documents

All downloaded and captured texts can be opened in the Note editor.

Received short messages, received mail and ASCII text files transferred to the
communicator are read-only documents. Read-only documents themselves
cannot be edited, but an editable copy can be created:

1 Open aread-only document. The contents are shown as plain text.
2 Press any character key. You will be asked if you want to create an editable
copy.

3 Press Create to close the original file and copy its contents to a new text
file. If the original file is in DOS format, it will be removed after an editable
copy has been created.

4 Edit the new note normally.

The contents of a received fax cannot be converted into text or edited.
Opening a fax activates the fax viewer and opening an image activates the
image viewer.
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Notes settings

You can change the default settings of the note editor by pressing Settings in
the Notes main view. The settings are valid until they are changed again.

Notes

To change the settings, choose a setting and press Change.
Font: URW Mono / URW Roman / URW Sans
Size: 10 points/12/14/18/24 /36 / User defined

Margins —Opens a new view where you can define values for the top, bottom,
left or right margin. The unit of measurement used in this setting is either
inches or centimetres, and it can be changed in the System settings.
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Calendar

Reserve whole day(s) —You can write down the number of days required for
the event.

Start:

Date — The date of the event. The default date is that of the selected day. The
date format is set in the System settings.

Time — The time when the event starts.

End:

Date — The date when the event ends.

Time — The time when the event ends.

Alarm — Sets an alarm for the selected event. See "Alarms" on page 111.

Frequency — You can define how often the event repeats. The options are
None /Daily Weekly [Monthly /Annually/Every other week/Working days.

Repeat until: [date] — You can write down the last date of the recurring event.

Event sent to — Lists all the people to whom you have booked the event. The
list shows the status of the sent event:

Accepted or Confirmed — The recipient has accepted the booking.
Discarded — The recipient has rejected the booking.

No reply — No information has been received from the recipient.
Forced — The booking was sent as a reservation.

To attach memos to an event

1 Move the selection frame over the desired event and press Details in the
daily schedule.

2 Press Memo.

3 Write the memo. The following command buttons are available:
Send — You can send the memo as a fax, SMS or mail.
Style — You can format the text.
Delete — Removes the memo.
Close — Links the memo to the selected event.

Memos are stored in the Calendar memos subfolder of the Own texts folder.

To use the Menu button

When you press the Menu button in the monthly, daily and weekly schedules,
the following options become available:

To-do list — Opens the To-do list. Available in the daily schedule only.
Pending requests — Opens the list of pending calendar event requests.
Today — Shows the current day.

Next month/week/day (Ctri-N)— Shows the next month, week or day.
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System

1 Make sure that the infrared port of your communicator faces the infrared
port of the other device.

2 Open the Digital camera connectivity application and press Image list.

3 Press Receive to start transferring the selected UPF images from the other
device to your communicator.

To transfer images from the communicator to another device

1 Open the Digital camera connectivity application and press Image list.

2 Select the UPF image(s) you want to transfer.

3 Make sure that the infrared port of your communicator faces the infrared
port of the other device, and press Send.

To rename the selected image, press Rename and write the new name in the
input field. Do not change the extension at the end of the name.
To use the Menu button

When you press the Menu button in the Image list, the following options
become available:

Open — Opens the image. When the image is open, you can print it, or send it
as SMS, fax or e-mail.

Delete — Removes the image.
Convert to JPEG — Converts the selected image(s) from UPF to JPG format.
Convert to UPF — Converts the selected image(s) from JPG to UPF format.

Image information — Presents information about the image. You can also
view the information with the Ctrl-i key combination.

Remote synchronisation

To synchronise your calendar data with a PC calendar, use the Remote synchronisation
application. With this application, you connect to the PC via the Internet. Note that
you need an Internet access point, see "Internet settings” on page 74.

The PC Suite for Nokia 9110 Communicator program must be running on the
PC to which you are connecting.

To synchronise calendar data

1 Press Settings and define the destination host, which is the IP address of
the server PC, and select the Internet access point used.

2 Press Start. A data call is made, and the calendar data is sent from your
communicator to the destination host.

3 When the synchronised calendar data has been sent back to your
communicator, the data call ends.

Verizon Wireless
Exhibit 1082-0175












Verizon Wireless
Exhibit 1082-0179






—_
N
o2}

Extras

The results of the calculations appear in bold. As long as you have not pressed

Enter or "=", you can move in the calculation string with the arrow keys and
edit the string.

The following characters can be used for the corresponding operations:

Character F;unction

Numbers 0 to 9

. (full stop) decimal point

+ addition

- subtraction

* multiplication

/ division

0) brackets

= or Enter sum

Esc clears the entry field

To add functions in the input field
1 Press Functions.

2 Select one of the available categories and press Select. You will see a list
of functions and you can select the one you want. You can select several
functions before returning to the Calculator main view.

To copy calculations in the input field

1 Press Copy to select and copy a calculation or a result back to the input
field for modification or recalculation.

2 To copy a calculation, press Copy calculation, and to copy a result, press
Copy result.

3 Press Back. The selected item will be copied to the input field.

To change the mode of the calculator

When you press the Menu button in the Calculator main view and select
Settings, you can change the mode of the calculator. Select either Radians,
Degrees, or Gradients, and press OK.

Clock

The Clock shows the time and date in your home city and country, as well asin
several other cities and countries in the world. The Clock also includes an
alarm clock.
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In this submenu, you can change the lock code, the PIN code, the PIN2
code and the barring password. See "Security” on page 115.

Phone

The access codes may only include the digits O to 9.
System lock (Menu 4-3-7)

To lock the communicator, press Select and enter your lock code. The
communicator locks immediately. Even if you remove and replace the
battery and switch on the phone, the communicator will remain locked.

To unlock the communicator, press Unlock and enter the lock code.

Restore factory settings (Menu 4-4)

You can reset the settings of the menu functions to their original values.
When you activate this setting, you will be prompted for your five-digit lock
code. This function will not affect stored phone numbers and names, access
codes, earpiece volume setting, call timers, cost counters, selected application
tones or short messages.

Call divert (Menu 5)

The call divert network service allows you to direct your incoming voice calls
to another phone number when you do not want to be disturbed, or when the
phone is switched off or outside the network coverage area. The call diverting
functions are described in more detail in “Telephone settings” on page 53.
1 Scroll to one of the following divert options and press Select:

Divert all voice calls

Divert when busy

Divert when notanswered

Divert if notreachable

Divert all fax calls

Divert all data calls

Cancel all diverts

2 Scroll to Activate. You will be asked for the phone number to which you
wish to divert the incoming calls.
The Canceloption sets the divert mode off. Statusshows what kind of calls
are being diverted.
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Troubleshooting

4. Internal memory or system errors

Sometimes, for example, removing the battery in mid-operation may cause
errors in the file system of the communicator. If you receive internal memory
or system error messages and/or reboot prompts, or if the device does not
respond to commands normally, resetting the communicator helps you
recover from most of these problems. Try the reset operations in the order
they have been listed: if checking the file system does not help, try removing
temporary files, or format the file system.

To reset the communicator

1 Close the cover.

2 Remove the memory card if inserted.
3 Remove the battery.
4

Place the connector end of the battery in the battery cavity, but do not
press the other end in place yet. The connector end is the one with the four
metal strips.

5 Place the communicator on a flat surface with the phone display upwards.
Do not let the battery slip from its place.

6 Open the cover.

7 Press and hold down the required key combination (see below) and
simultaneously push the battery end of the communicator down, so that
the battery clicks into place. Hold down the keys until you see progress
messages or a confirmation prompt on the display.

8 In some cases you must confirm the action by pressing a command button.
After the reset, the communicator will reboot and start normally.

To check the file system

Symptoms: The Memory application in the System application group shows
too much (over 2 megabytes) or too little memory, even if you have just
removed some documents, or the communicator applications crash when
opening a document.

Key combination: Shift-Tab-left arrow

Caution: If there are problems in the file system, the corrupted files will be
removed. If there are no problems, this operation does not affect any
documents or settings.

To remove temporary files

Symptoms: The communicator is in a reboot cycle or a note saying that an .ini
file is corrupted is displayed.

Key combination: Shift-Tab-right arrow

Caution: All temporary files will be removed. The Document outbox will be
cleared, the default application settings restored, but for example, the SMS
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11. Infrared problems

The communicator may be connected to a PC, laptop, printer, digital camera,
wireless phone or another communicator via the infrared link.

Troubleshooting

If you are using the PC Suite for Nokia 9110 Communicator program on your
PC, or if you want to receive data from another communicator or a digital
camera, you will have to start the Infrared activation application on your
communicator before the connection is made. See “Infrared activation” on
page 118.

If you are using the Nokia Communicator Server program on the PC, the
infrared connection is established automatically when you use one of the PC
connectivity applications of the communicator.

The PC to which you want to establish the connection must have an IrDA
compatible infrared port; installed and activated IrDA drivers; and Microsoft
Windows 95. For more information on IrDA drivers and their use in Windows
95, contact Microsoft.

For further information, see the Documentation section on the CD-ROM in the
sales package of the communicator.

12. Printing problems

If you are using the infrared connection, the infrared port of the printer must
be compatible to the IrDA standard. See "Document features” on page 24.

If you fail to establish an infrared connection, transfer the file to a PC and use
the PC to print the document. Alternatively, you can fax the document to the
nearest fax machine. See "To send faxes" on page 59.

Check that your printing settings are correct, see "System settings” on page 113.
You may be using an incorrect printer driver, see "Document features" on page 24.

13. PC connectivity problems

Make sure that the correct PC connectivity program is installed and running
on your PC. See chapter 4 "PC connectivity" on page 29.

Check the cable or infrared connection used. If you use an infrared
connection, the IR ports must be facing each other.

Check that you are using the correct COM port.

14. Fax modem problems

When you use the communicator as a fax modem, make sure that the
communicator and the PC use the same baud rate. If you use the infrared
connection, the baud rate is set automatically. If you use the cable
connection, set the baud rate in the Fax modem settings. For the PC, the baud
rate is set in the connectivity software of the PC.

Ifyou use the cable connection, fully compatible operation with all PC fax and
terminal software cannot be guaranteed. Consult your dealer. If you have
problems with your PC fax software, use the infrared connection.
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Should use the ear opposite the pacemaker to minimise the potential for in-
terference.

If you have any reason to suspect that interference is taking place, switch off
the phone of your communicator immediately.

Hearing aids: Some digital wireless phones may interfere with some hearing
aids. In the event of such interference, you may want to consult your service
provider.

Other medical devices: Operation of any radio transmitting equipment,
including communicators, may interfere with the functionality of
inadequately protected medical devices. Consult a physician or the
manufacturer of the medical device to determine if they are adequately
shielded from external RF energy or if you have any questions. Switch off the
phone of your communicator in health care facilities when any regulations
posted in these areas instruct you to do so. Hospitals or health care facilities
may be using equipment that could be sensitive to external RF energy.

Vehicles: RF signals may affect improperly installed or inadequately shielded
electronic systems in motor vehicles (e.g. electronic fuel injection systems,
electronic anti-skid (anti-lock) braking systems, electronic speed control
systems, air bag systems). Check with the manufacturer or its representative
regarding your vehicle. You should also consult the manufacturer of any
equipment that has been added to your vehicle.

Posted facilities: Switch off the phone of your communicator in any facility
where posted notices so require.

Potentially explosive atmospheres

Switch off the phone of your communicator when in any area with a
potentially explosive atmosphere and obey all signs and instructions. Sparks
in such areas could cause an explosion or fire resulting in bodily injury or even
death.

Users are advised to switch off the phone when at a refuelling point (service
station). Users are reminded of the need to observe restrictions on the use of
radio equipment in fuel depots (fuel storage and distribution areas), chemical
plants or where blasting operations are in progress.

Areas with a potentially explosive atmosphere are often but not always clearly
marked. They include below deck on boats; chemical transfer or storage
facilities; vehicles using liquified petroleum gas (such as propane or butane);
areas where the air contains chemicals or particles, such as grain, dust or
metal powders; and any other area where you would normally be advised to
turn off your vehicle engine.

Vehicles

Only qualified personnel should service the communicator, or install the
communicator in a vehicle. Faulty installation or service may be dangerous
and may invalidate any warranty which may apply to the unit.

Check regularly that all wireless phone equipment in your vehicle is mounted
and operating properly.
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Glossary

HTML (Hypertext Markup Language)

A language used to define the appearance and content of WWW
documents.

HTTP (Hypertext Transfer Protocol)
A document transfer protocol used in the WWW.

Hyperlink

Hyperlinks are used to move from one WWW page to another.

IAP (Internet Access Point)

The point where your communicator connects to the Internet by
way of a data call. An Internet access point can be provided, for
example, by a commercial Internet service provider or by your own
company.

Images, inline, external

Images within a fetched WWW page are inline images. Larger
images are often placed as external images and have to be viewed
separately.

IMAP4 (Internet Mail Access Protocol, version 4)
A protocol used for accessing your Remote mailbox.

IP (Internet Protocol) address

All computers and other devices connected to the Internet using
the Internet Protocol have their own individual addresses. The
address consists of four numbers separated by points: for example,
131.227.21.167.

Lock code

The lock code is a five-digit code needed to lock and unlock the
communicator. The lock code is also required when you change
certain settings. You will find the lock code on a sticker in the sales
package of your communicator. Keep it secret and in a safe place,
separate from the communicator.

MCN (Micro-Cellular Network) technology

Microcells are used for increasing the capacity of wireless networks
in urban areas.

MIME (Multipurpose Internet Mail Extensions)

A standard Internet format which permits including multiple mail
objects in a single message. The mail objects can be, for example,
formatted multifont text messages and non-textual elements, such
as images and audio fragments.
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PIN (Personal Identity Number) code

The PIN code protects your phone from unauthorised use. The PIN
code is supplied with the SIM card. If the PIN code request is set on,
the code is required each time the phone is switched on. The PIN
code must be 4 to 8 digits long.

PIN2 code

The PIN2 code is supplied with some SIM cards. The PIN2 code is
required to access certain functions supported by the SIM card. The
length of the PIN2 code is 4 to 8 digits.

Glossary

Plug-in

A plug-in is add-on software that can be downloaded from the
WWW. The communicator uses plug-ins to display a document that
the WWW application itself cannot show.

POP3 (Post Office Protocol, version 3)

A common mail protocol that can be used for accessing the Remote
mailbox.

PPP (Point to Point Protocol)

A common networking software protocol which enables any
computer with a modem and a phone line to connect directly to the
Internet.

Protocol

A formal set of rules that govern how data is transferred between
two devices.

Proxy

In some networks, the connection between the WWW and the site
you want to connect to is blocked by a firewall. The firewall
protects the network from unauthorised external access. A proxy is
an intermediary program that enables access through the firewall.
A proxy can also serve as a network cache to speed up the fetching
process.

PUK (PIN Unblocking Key) code

The PUK is an 8-digit code supplied with the SIM card. The code is
required when you want to change a disabled PIN code. Ifyou enter
an incorrect PUK code ten times in succession, the SIM card is
rejected and you cannot make or receive any calls, except
emergency calls. When the SIM is rejected, you will need a new SIM
card.

You cannot change the PUK code. If you lose the code, contact your
network operator.
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Glossary

PUK2 code

The PUK2 code is supplied with some SIM cards. The code is
required when you want to change a disabled PIN2 code. If you
enter an incorrect PUK2 code ten times in succession, you will not
be able to access the functions which require the PIN2 code. To use
these functions again, you will need to obtain a new SIM card from
your network operator.

You cannot change the PUK2 code.
SIM (Subscriber Identity Module) card

The SIM card contains all the information the cellular network
needs to identify the network user. The SIM card also contains
security-related information.

SMTP (Simple Mail Transport Protocol)
An Internet protocol governing the transfer of electronic mail.

SSL (Secure Socket Layer)

A security protocol that prevents eavesdropping, tampering, or
message forgery over the Internet. Documents using SSL are
identified with the prefix HTTPS.

TCP Port

Identifies the data port of the destination computer.

TCP/IP (Transmission Control Protocol/Internet Protocol)

A protocol that governs data communication in the Internet and in
the TCP/IP networks.

URL (Uniform Resource Locator)

Link information required by the WWW to connect to a given
WWW host computer. The URL usually starts with http;//followed
by www. For example, the Nokia Wireless Data Forum home page
can be found at http://www.forum.nokia.com. URLs are often
referred to with phrases like "Home page location," "Site location,”
“can be found at..."

Voice mailbox

A voice mailbox is a network service or a personal answering
machine where people can leave you voice messages.
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Index

Index

Alarms

Calendar 111

Clock 127
Alternate phone line service 148
AT commands 121, 165
Autolock 117

Backlight
Settings 114
Turning on 21
Barring password 118
Battery 17
Charging 17
Booking events 109
Cancelling and changing bookings 110
Business cards 69

Cable connection 30
Cache 85
Emptying 91
Calendar
Adding events 107
Alarms 111
Booking password 109
Cancelling and changing bookings 110
Memos 108
Receiving bookings 110
Sending bookings 109
Caller groups 54
Calls
Alternate lines 148
Alternating calls 52
Answering 48, 138
Answering a waiting call 52
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Index

Anykey answer 147
Automatic redialling 147
Barring 56, 149
Closed user group 150
Conference call 51, 138
Diverting 55, 151
Fixed dialling 150
Making a call 47, 137
Making a new call 51, 138
Making an emergency call 163
Poor call quality 4, 155
Putting on hold 138
Recording conversation 49, 138, 152
Showing costs 48, 145
Showing duration 145
Switching between calls 50
Transferring 52, 139
Waiting call 56, 147
Chr key 101
Cities
Changing home city 129
Editing and adding 128
Selecting destination city 128
Cleaning the communicator 159
Clock settings 129
Codes
Lock code 118
PIN code 117
PIN2 code 117
PUK code 167
PUK2 code 168
Composing tunes 129
Conference call 51
Contact card
Adding fields 41
Attaching an image 42
Creating 41
Customising fields 42
Setting an individual ringing tone 42
Template 40
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Index

Creating 44

Contrast control 115
Costs 48

Date format 115
Delivery reports 71
Diverting calls 55
Document outbox 26
Documents

Printing 100

Reading 99

Read-only documents 102
Sending 102

Transferring via IR 100
Writing 99

Downloaded files

Installing 91
Opening 102

DTMF tones

Sending 52, 140
Special characters 43
Storing 43

Emergency calls 163

Fax

Adding a logo 63
Adding a signature 63
Barring 63

Cover page settings 62
Diverting 63
Forwarding 59
Printing 62

Receiving 61

Sending 60

Setting sending time 63
Writing 59

Fixed dialling 150
Flight profile
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Index

Setting on 57
Folders
Creating 100
Removing 100
Font 101
Formatting the file system 155

General log 45

Handsfree mode 49

Help
Application help 22
General help 22
Phone 141

Images
Contact images 42
Transferring 119
WWW images 91
Import/Export
Calendar 35
Contacts 35
Indicators 12
Individual log 45
Info service
Reading 143
Settings 71, 144
Infrared connection
Connecting to a communicator 119
Connecting to a PC 30
Connecting to a printer 25
Internet
Access requirements 73
Autodisconnect time 75
Data call barring 75
Defining an access point 74

Keyboard 14
Keypad 135
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Index

Lock code 118

Locking
Communicator 115, 151
Keypad 141

Logs 45

Mail
Adding a signature 80
Adding attachments 81
Fetching 82
Fetching attachments 79
Font 78
Forwarding 84
Opening attachments 83
Printing 84
Reading 83
Remote mailbox 82
Removing messages 83
Replying 84
Sending 80
Sending upon request 81
Timed fetching 80
Writing 80
Margins 101
Memory
Cache 85
Details 118
SIM memory 44
Memory card 22
Inserting 22
Menu button 21
Message centre number 70
Messages
Info messages 71, 143
Short messages 65, 143
Multiselection 23

Network
Selecting 149
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Settings 55
Nokia Careline contact card 39, 105
Nokia Communicator Server
Installing 36
Nokia Wireless Data Forum 153
Notes
Sending 102
Writing 99

Own number sending 55, 148

Passwords
Barring password 118
Booking password 109
Internet password 76
Mail password 79
WWW password 87, 89
PC connectivity
Cable connection 30
Infrared connection 30
PC Suite for Nokia 9110 Communicator
Installing 30
PIN code 117
PIN2 code 117
Printing 25
Cable connection 26
Documents 100
Faxes 62
Infrared connection 25
Mail messages 84
Settings 114
SMS messages 68
Profiles
Modifying 53, 147
Setting on 146
PUK code 167
PUK2 code 168

Read-only documents
Opening 102
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Receiving
Fax 61
Mail 82
SMS 67
Recorder
Playing a recording 132, 152
Recording 132, 152
Remote mailbox 77, 82
Resetting the communicator 154
Ringing tones
Alternate ringing tone 113
Composing 129
Recording 132
Selecting 113
Sending 131
Setting individual tones 42
Settings 54

Safety information
Electronic devices 161
Operating environment 161
Traffic safety 161
Vehicles 162

Screen blanker 115

Search field 11, 39

Selection frame 10

Sending
Documents 102
DTMF tones 52
Mail 80
SMS 66

Service cards 68

Shortcuts 24

Signal strength 5
Indicator 13, 137

SIM card
Installing 7, 22
Viewing contents 44

SMS
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Forwarding 68

Receiving 67, 143

Replying 68

Sending 66

Setting message centre number 70

Writing 66
Special characters 101
Speed dialling

Settings 43

Using 139
Standard messages 68

Telnet
Defining connections 95
Special keys 96

Terminal
Defining connections 93
Special keys 94

Text Web
Defining services 97
Fetching information 97

Time format 115

Tones
Adding ringing tones 100
Application tones 114
Composing 129
Notification tone 114
Recording 132
Ringing tones 54, 113
Sending 131
Silencing 53

Transferring
Calls 52
Data from older communicator models 27
Data from other handheld devices 41
Text (Telnet, Terminal) 94

Unit of measure 115
Unlocking
Communicator 116, 151
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Keypad 141

Index

Voice mailbox
Calling 57, 136, 140, 144
Setting number 57, 144
Volume
Adjusting loudspeaker 49
Communicator key click 54
Phone key click 54
Ringing tone 54

Welcome note 148

World time 128

World Wide Web
Access requirements 85
Adding bookmarks 86
Copying text 90
Creating a bookmark folder 87
Downloading software 91
Fetching a page 86
Following a hyperlink 90
Navigation commands 90
Saving a page 91
Saving the HTML format 87
Timed fetching 88
Viewing images 91

Zoom button 21
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1. ABOUT THIS DOCUMENT

This is a design guide for content providers seeking to produce usable WWW pages with
HTML for the Nokia 9110 Communicator browser. This guide outlines some of the basic
considerations that should be taken into account when designing web sites for the
communicator.

A basic understanding of the words WWW, HTML, HTTP, browser, page, screen, pixel
and bit is necessary to benefit from this document. Additional reference material is listed
at the end of this guide.

This guide is not a general HTML style guide [Lynch, 1995], a general communicator
design guide [GO, 1992] nor an HTML syntax check [Halsoft, 1995]. For more information
on these subjects, refer to the references section at the end of this document. If a conflict
between the suggestions of this document and other referenced documents arises, this
document should be given preference.

2. HTML CONSIDERATIONS

The basic HTML for the communicator should be based on the HTML 3.2. There are some
minor exceptions and limitations which must be taken into account. These restrictions
are set mainly by the size of the view and by the layout capabilities of the system. E.q. it
is not always possible to handle element positioning or image sizing as defined in HTML
source code. These and other design suggestions will be discussed in this document.

The browser parser in the communicator is not strict and will not attempt to interpret
HTML tags it does not support. Note that the basic screen and graphic design for the
communicator is radically different from a desktop computer To maximise the properties
of both platforms, WWW page versions should be created for both the communicator and
PC platforms. HTML comments, excessive white space, non-usable tags, and heavy
graphics should be avoided to ensure maximum download speed.

3. SUPPORTED PROTOCOLS AND MIME TYPES

The protocols that can be used in fetch operation by default are listed in the following
table.

Protocol Description
File Protocol for fetching local files.
Http Hypertext transfer protocol.
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Https Protocol for SSL (Secure Socket Layer).
SSL is a transparent software layer that is
located above TCP/IP and below the
application protocols in the protocol stack.
SSL enables to transfer the user’s sensitive
data over a public network securely.
WWW browser of the Nokia 9110
Communicator has SSL version 3
capability.
Mailto Protocol to send email from WWW page.
Opens up a Mail editor.
Gsms Protocol to send short messages from
WWW page. Opens up a SMS editor.
Gsm-sms Protocol to send short messages from

WWW page. Opens up a SMS editor.

Vnd.nokia.sm | Protocol to send short messages from

s WWW page. Opens up a SMS editor.

Phone Protocol for establishing voice call from
WWW page.

Tel Protocol for establishing voice call from
WWW page.

ne WWW page.

Vnd.nokia.pho | Protocol for establishing voice call from

The following MIME types are supported by WWW:

*/*

Unknown MIME types

Application/vnd.nokia.ringing-tone .rng Communicator ringing tones
Application/ringing-tone .rng Communicator ringing tones
Application/x-nokia-9000- .aos AOS files
communicator-add-on-software
Application/vnd.nokia.configuration- .ncm | Configuring Smart Message
message file
Audio/wav .wav | Wav audio file
Audio/x-wav .wav | Wav audio file
Image/qif .gif GIF image
Image/jpeg Jpg, JPEG image

jpe
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Text/html .html, | Html file
.htm
Text/plain xt Plain text file

4. PAGE LAYOUT CONSIDERATIONS

The size of the 9110 Communicator screen is 200 x 640 pixels. The pixel shape is
rectangular and the pixel pitch is 0,17mm. The display is able to show 16 grey tones. The
area displaying WWW-page content is 200 X 540 pixels, as a part of the screen is covered
by the browser options and window.

4. 1. The Text

The standard text size is 12 points, with support for both mono-spaced and variable-
spaced typefaces. Underline, bold and italics styles are also supported. All text links are
displayed as underlined. All levels of headings (H1-H6) are supported. Text to be read
first should be formatted to fit on the first screen of the page.

Note that preformatted text (<PRE> tag) should be avoided as the user cannot resize the
window of the browser. Approximately 75 characters fit on a single line when the basic
text size is used. This is dependent on which letters are in the text (i’s are thinner than
m’s).

Underlined text should not be used, since the communicator underlines all links.
Underlined text, therefore, appears as a link to the user.

When displaying pre-sized text, lines which are too long for the screen continue onto the
next line making all the text available to the reader.

It is not useful to use pictures as bullets when making lists. This can mix the list up and
could cause the user wonder what the pictures are for if they are not auto-loading
images.

4. 2. Tables

The Nokia 9110 Communicator Browser supports tables. There is a table button, which is
a button icon opens a separate table viewer to display the table. Table viewer is
horizontally and vertically scrollable note. It contains a cursor that can be moved to
enable select and copy of the table contents.

Arrow keys move the cursor by cells. It is possible to move the cursor inside the cell with
Ctrl + arrow key. Shift + arrow selects the text in one cell. Ctrl + h moves the focus to
upper left corner of the table. Ctrl + e moves the focus to lower right corner of the table.
Chr + arrow scrolls one screenful in the selected direction.
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Title line in the viewer displays the string from the CAPTION tag on the left side. Right
side of the title line shows the cell coordinates for the current position of the cursor, for
example 2,3 for column 2 and row 3.

As long as HTML table does not contain images or links and the rows fit to one row (app.
60 chars) in the Browser view, the table is displayed in the browser view. If the table
contains images or links and several small cells, the table is displayed in the Browser
view, but the table button is available. If the table contains images or links but several
small cells are not found, the table is displayed in the Browser view without table button.
If the table contains form elements the table viewer is not available.

4. 3. Frames

Each frame will be displayed as a link. If a web page has four frames, the communicator
will show four corresponding links. When a link is selected, it will take the browser to a
new page which shows the content of the frame chosen.

NOTE: It may cause user problems, if cookies are used within a frame document. User
should then load the correct frame before cookie is handled.

4. 4. Movement Within a Page

The user moves from one discrete link to another by using the scroll keys on the
communicator. The scroll keys move the browser to the next line or next hyperlink. The
active area of the page also changes accordingly. The Chr and scroll keys can be used to
scroll a full screen of material at once. Ctrl -H can be used to move to the beginning of
the page and Ctrl-E to move to the end of the page. There is no cursor for continuous
scrolling through the page. Since free movement within a page is restricted, links should
be carefully placed. Hierarchical pages are easier for the user to navigate than a single
long page.

4. 5. Hierarchy

A good rule is that a page should not have more than five hyperlinks unless it is a
selection menu listed with proper sub-headings. A maximum of three hierarchical levels
are recommended for casual browsing. If more than three hierarchical levels are
required, the designer should ensure easy navigation between the levels. This is
especially important in sub-categorised hierarchies of three or more levels. Give the user
a chance to go back easily to a sub-category home page as well as to the main home
page. Again, avoid long pages as downloading and navigating them can be slow.

5. GRAPHICS CONSIDERATIONS

The graphics display attributes of the communicator should be taken into account when
incorporating graphic images. In addition to the size and depth attributes of the display,
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other important considerations are the communication speed of the browser, the speed
of the HTTP protocol, and the use of image maps (ISMAP). When displaying paragraph
text, approximately 75 characters can be displayed. Use the ALT attribute to specify a text
string that the browser can display as an alternative to the in-line image.

5. 1. Display Attributes

Pre-rasterizing of all pictures with more than 8 shades of gray is recommended. A
stochastic raster with 8 shades of gray works best in most cases. Images with large
uniform color areas look better than heavily screened images. Images place horizontally
in a normal-sized screen (desktop or laptop PC) will be displayed vertically on the
communicator. Pictures can be loaded faster using RLE compression, which is important
because of the transfer rate.

An external picture should not be larger than 570 X 200 pixels, because this size fills the
whole screen. The maximum dimensions for inline pictures are 540 X 200 pixels. If a
picture exceeds the maximum width, the picture will be zoomed out using standard
factors (1:2, 1:3, etc.). For example, if the inline image width is 541 pixels it will be
zoomed out using the factor of 1:2 and be displayed as 270 pixels wide. An image with a
540 pixel width will be shown full-size using the entire screen width. The height of a
image is not so important, as the screen can be scrolled up and down.

GIF, JPG , and UPF (Uni Picture Format, format of the IrTran-P digital camera images)
format pictures can be viewed with external image viewer, but progressive JPEG
compression should not be used. A maximum of four images per page is recommended.
General image size should not exceed 10 kilobytes. Since a user can turn off image auto-
loading, it is advisable to warn the user if you are offering a graphics-intensive page.

6. DATA TRANSFER SPEED CONSIDERATIONS

The HTTP protocol specifies a “slow start”, which slows down the start of each HTTP
transfer. The HTTP protocol is also connectionless, requiring all images on a page to be
retrieved with their own HTTP request. Each request takes time to execute due to
negotiation overhead of the protocol. Considering the data transfer speed of the
communicator (9600 bit/s or 14400 bit/s if supported by the GSM network), the number of
images on a page should be evaluated carefully and all image sizes should be kept to a
minimum. It should not take more than 10 seconds to fetch and display a typical page on
the communicator browser.

It is often better to use one large image map rather than separate images, because one
image loads faster than several smaller images. Since image maps are somewhat slower
to navigate than text links, they should only be used where needed.
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7. MULTIMEDIA CONSIDERATIONS

The 9110 Communicator Browser supports WAV format. WAV audio files can be fetched
and files can be played using Digital Voice recorder.

The WAV files can not be played simultaneously with an active data call. When an audio
file is downloaded and there is an active data call, the file is stored in Tones folder.
Animated GIFs are not supported. Only the first picture from the series will be displayed.
If the animation is saved to the Downloaded files folder, the animation will be played as
whole when opened.

8. LINK CONSIDERATIONS

All links are displayed as underlined text. To avoid confusion between links and other
text, do not use underlining for text emphasis. Note that the emphasis tag (<EM>) may
also produce an underlining effect for the text emphasized.

Link placement should allow users to clearly distinguish between links on the page. For
example, two short words (links) side-by-side may not appear as separate links to the
user. Links that go semantically together should usually be placed so that the user does
not have to scroll down to the next screen in order to access the next link.

Links that together form a set of choices, from which the user selects one link, should all
be visible at the same time on the screen. This helps the user to see the hyperlink
options in a glance, without having to scroll up and down the page. The chance that a
link will not be noticed is reduced if links are grouped properly.

The mail-to HREF-link is supported, but communicator does not support other data
transfer protocols (i.e. wais, ftp, gopher) and they should not be offered. If there is a need
for these services, an http gateway should be set up to provide these services for the
user.

The user can keep a list of personal bookmarks on the communicator, but this capability
should not be used to force the user to add new links to the list in order to properly
navigate a certain WWW hierarchy.

9. OTHER CONSIDERATIONS

WWW browser of the Nokia 9110 Communicator has two different cache systems. The
basic “online” cache stores the documents that are fetched with normal fetch operations.
This cache has maximum size of 300 kb. Older documents are removed when the cache
is full and new documents are fetched. The other “offline cache” stores only documents
that are fetched with timed fetching. This cache does not have a fixed maximum size. All
fetched items, except secure documents and documents that are fetched with HTTP
headers “Cache-Control:no-cache” or “Pragma:no-cache”, are stored in the cache.
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Authentication (inserting a name and password in a dialog) is also supported and can be
used. Forms or dialogs requiring heavy text input should be avoided so the user is not
overwhelmed with data entry. Users are likely to avoid pages that are too cumbersome to
use. When the authorization data is asked for the second time in the same domain,
application offers automatically the username and password from the earlier contact. If
this fails the authorization dialogue is opened with default username. Successful
authorization is transparent to the user.

The Nokia 9110 Communicator WWW browser supports client pull (HTTP-
EQUIV="Refresh”) feature. It is also possible to set an automatic update to certain pages.

For best results, we recommend providing links to pages specifically designed for the
communicator browser, as well as other browsers, based on the browser identification
information which can be queried with the HTTP protocol. Pages should be optimized
with the appropriate level of HTML DTD, graphics, and links for each browser. When
designed properly, these pages offer maximum usability and can be used as templates
for the creation of additional pages. Templates allow the automatic generation of
additional pages with similar design elements and functions. Changes to the browser can
be accommodated by changes to the template, rather than to all of the individual pages
created for the browser.

The communicator browser name is “Nokia-Communicator-WWW-Browser/3.0 (Geos 3.0
Nokia-9110)”. The browser can identify itself by including the User-Agent request-header
field with requests. The User-Agent request-header field contains information about the
user agent originating the request. To ensure that users receive pages that are
compatible with the Nokia 9110 Communicator, use a script that checks the User-Agent
request-header field and returns the communicator-optimized pages.

10. CHECKLIST

A list of the major guidelines for designing WWW pages for the communicator is offered
here as a tool for checking page sketches or final designs. This checklist should be used
each time new pages are designed, or existing pages are modified. When designing
pages for the first time, an HTML manual [Tilton, 1995] and WWW design style guide
[Lynch, 1995] should be consulted first.

10. 1. Graphics

Use only HTML 3.2. Limitations are listed in this document.
The maximum file size of a single image is 10 kB.

Use a maximum of four images per page.

Images have been reduced to 10 grays or less.

The maximum image dimensions are 540 X 200 pixels.

Do not use progressive JPEG compression on images.
Horizontally placed images can be displayed vertically.
The ALT attribute is used with in-line images.
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« Itis recommended not to use frames.
10. 2. Text
« Underlining is not used for text emphasis.
« Most important text is visible at the top of the screen.
10. 3. HTML 3.2 DTD Commands Not supported By Communicator Browser

—
©
N

10. 5

APPLET element

BASEFONT element

FONT element

ISINDEX element

LINK element

SCRIPT element

STYLE element

U element

Attributes in A element: rel, rev

Attributes in BODY element: bgcolor, text, link, vlink, alink, background
Attribute in BR element: clear

Attributes in HR element: align, noshade, size, width

Attributes in IMG element: align, width, height, border, hspace, vspace
Attributes in OL element: type, compact

Attribute in PRE element: width

Attribute in SELECT element: size

Attributes in TABLE element: align, border, cellspacing, cellpadding
Attribute in CAPTION element: align

Attribute in TD element: nowrap, rowspan, colspan, align, valign
Attribute in TH element: nowrap, rowspan, colspan, align, valign
Attributes in TR element: align, valign

Attributes in UL element: type, compact

. Hierarchy

No more than five major links on a page (unless with lists)

No more than three major levels of hierarchy (unless the hierarchy is categorized
into sub-hierarchies)

Navigation back to the home page and sub-category home page is available.

. Links

Links are grouped to enable selection without scrolling
Links should be visually separate from each other

10. 6. Usability

Each page takes about 10 seconds to load and display
No links that point to multimedia data types
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10. 7. Browser ldentification

« The server identifies the 9110 browser and uses an optimized layout template.
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Copyright Notice

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system,
or translated into any computer language, in any form or by any means, without the express written
permission of Puma Technology, Inc.

Intellisync® is a registered trademark of Puma Technology, Inc.
Nokia 9110 Communicator is a trademark of Nokia Corporation.

All other company and product names are trademarks of their respective companies.

© Copyright Puma Technology, Inc. 1998. All rights reserved.
Puma Technology, Inc., 2550 North First Street, Suite 500, San Jose, CA 95131

Page ii

Verizon Wireless
Exhibit 1082-0248



END-USER NOTICE AND LICENCE AGREEMENT FROM PUMA TECHNOLOGY, INC.

NOTICE TO END-USER: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT (“LICENCE”).
INSTALLATION OR USE OF THE ENCLOSED PUMA SOFTWARE (“SOFTWARE”) ON YOUR COMPUTER
SYSTEM CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENCE, PROMPTLY DELETE THE SOFTWARE FROM YOUR COMPUTER SYSTEM,
DESTROY ANY COPIES YOU MADE OF THE SOFTWARE OR ANY INSTALLATION DISKETTES OF THE
SOFTWARE INCLUDED WITH YOUR SYSTEM, AND DISPOSE OF ALL WRITTEN MATERIALS IN YOUR
POSSESSION REGARDING THE SOFTWARE.

Licence Grant: In the case of PC Suite for Nokia 9110 Communicator Software, Puma grants to
You, as an individual, a licence to install and use one copy of the Software on a single computer at a
time. Your licence to use the Software is conditioned upon Your compliance with the terms of this
Agreement. A Licence is required for each end-user of the Software. A Licence is required for each
installation of the Software, unless the Software is (i.) installed temporarily on a PC owned by a third
party so that you can accomplish a file transfer, and (ii.) is immediately deleted from such PC. You
may make one (1) copy of the Software for archival purposes only.

Copyright: The Software is protected by United States copyright law and international treaty
provisions. You acknowledge that no title to the intellectual property in the Software is transferred to
You. You further acknowledge that title and full ownership rights to the Software will remain the
exclusive property of Puma, and You will not acquire any rights to the Software except as expressly
set forth in this licence. You agree that any copies of the Software will contain the same proprietary
notices which appear on and in the Software.

Prohibited Uses: Without obtaining prior written permission from Puma, You may not (a.) use, copy,
modify, alter, or transfer the Software or documentation except as expressly provided in this Licence;
(b.) translate, disassemble, decompile, reverse program or otherwise reverse engineer the Software;
(c.) sublicense or lease the Software or its documentation; or (d.) use the Software in a multi-user,
network, or multiple computer environment or in a rental, time sharing or computer service business.
Without prejudice to any other rights, Puma may terminate this Licence if You fail to comply with its
terms and conditions. In such event, You must destroy all copies of the Software.

Limited Warranty: Puma warrants that the Software will perform substantially in accordance with
the accompanying written materials for a period of thirty (30) days from the date of purchase. Any
implied warranties relating to the Software are limited to such thirty (30) day period.

End-User Remedies: If the Software does not conform to the “Limited Warranty” section above,
Puma’s entire liability and your sole and exclusive remedy shall be, at Puma’s option, either to (a.)
correct the error, or (b.) help you work around the error. The Limited Warranty is void if failure of
the Software has resulted from accident, abuse, or misapplication. Any replacement software will be
warranted for the remainder of the original Limited Warranty period.
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No Other Warranties: PUMA DOES NOT WARRANT THAT THE SOFTWARE IS ERROR FREE, EXCEPT
FOR THE EXPRESS LIMITED WARRANTY IN THE “LIMITED WARRANTY” SECTION. PUMA DISCLAIMS
ALL OTHER WARRANTIES WITH RESPECT TO THE SOFTWARE, EITHER EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. SOME JURISDICTIONS
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS OF HOW LONG AN
IMPLIED WARRANTY MAY LAST, OR THE EXCLUSION OF LIMITATION OF INCIDENTAL DAMAGES,
SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM
JURISDICTION TO JURISDICTION.

No Liability for Consequential Damages: IN NO EVENT SHALL PUMA BE LIABLE TO YOU FOR ANY
CONSEQUENTIAL, SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF
THE PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF PUMA HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

U.S. Government Restricted Rights: Use, duplication or disclosure of the Software by any agency,
department or other entity of the Government is restricted in accordance with FAR 12.212 for civilian
agencies and DFARS 227.7202 for military agencies. The Software is a commercial product. Use of
the Software by the Government is further restricted by the terms of this Licence.
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Before You Begin

Chapter 1 : Before You Begin

This chapter introduces PC Suite for Nokia 9110
Communicator and instructs you on how to get
started using the software.

Topics include:

*

*

*

Introduction to PC Suite for Nokia 9110 Communicator
System Requirements

Installing the Software

Program Icons

The Opening Screen

PC Suite Menu Commands

Shortcut Commands

Component Icons

Before Configuration

The Preferences Dialogue

Communicator Recognition

Preparing Your Communicator for a Data Transfer

Desk Stand Button Settings
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Introduction to PC Suite for Nokia 9110

Communicator

PC Suite for Nokia 9110 Communicator is a suite of functions
that allow for the easy transfer of data between your Nokia 9110
Communicator and the PC applications you rely on most.

¢ PC Suite’s Intellisync® component lets you synchronise
your Nokia 9110 Communicator’s Contacts, Calendar, and
To-do list applications with a host of popular Windows
applications.

¢ The Contacts application provides a PC Contacts file that is
compatible, field-for-field, with your communicator’s
Contacts application.

¢ The Backup/Restore component lets you back up the data
on your Nokia 9110 Communicator for safe keeping, and
restore it if need be.

¢ Import/Export functions import and export Calendar and
Contacts files between your communicator and PC.

¢ The Install/Remove component installs software to and
removes software from your communicator.

¢ File Transfer functions let you select, move, copy, paste,
rename, and delete communicator or PC files in a Windows
Explorer-type environment.
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System Requirements

In order to use PC Suite for Nokia 9110 Communicator, your
PC must meet the following minimum system requirements:
Windows 95, Windows NT 4.0

IBM-compatible 486 PC or higher

15 MB available hard disk space

VGA monitor or better

CD ROM drive

* & 6 ¢ oo o

One available serial or infrared port

Installing the Software

Follow these steps to install the PC Suite software on your PC:

1. Insert your CD into your CD ROM drive. The program
should launch itself automatically. If it does not, continue
following these instructions.

2. Click the Windows Start button; then click Run.

3. Type d:\9110.exe in the command line (substitute the letter
“d” with the letter of your CD drive).

4. Press Enter.

5. A series of screens is presented. Follow on-screen
instructions, and note:

¢ You are asked to specify the PC COM port you will use to
connect your communicator to your PC. If you will be
connecting via infrared, check the box labelled Infrared
Port.
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¢ You are given the option of performing a Complete or
Custom installation. If you choose Custom, you are
presented with a screen labelled Select Components. This
screen lists the PC applications supported by the PC suite
Intellisync function. Un-checking an application in this
screen removes support for that system. (Thus, cutting down
on the disk space used by PC Suite.)

Note: If you un-check a PC application in this screen, but
later want to restote suppott for that system, re-install PC
Suite and check the application in the Select Components
screen. (Don't un-install Intellisync before re-installing.) To

avoid losing custom settings (including field mapping) un-
check PC Suite Program Files in the Sclect Components
screen. A re-installation of the software is the only case in
which you should un-check PC Suite Program Files.

When installation is complete, a program group containing a set
of PC Suite icons will have been created.

* To access the program group, click Programs on the
Windows Start menu. Then click on PC Suite for Nokia
9110 Communicator.
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Before You Begin

Note that you can
“drag and drop”
component icons to
re-order them on the
PC Suite screen.

Component Icons

Component icons are located on the left side of the PC Suite
opening screen. These work as follows:

The Contacts icon starts the Contacts application,
which installs with PC Suite to provide field-for-
field compatibility with your Nokia 9110
Communicator’s Contacts application.

The Synchronise icon accesses the Intellisync
component, which synchronises, imports, or exports
data between records in your communicator and PC
application.

The Import/Export icon accesses the PC Suite
Import/Export function, which transfers Calendar
and Contacts files between your communicator and
your PC.

The Backup/Restore icon accesses PC Suite’s
Backup and Restore functions, which can be used
to backup and, if need be, restore, the data on your
Nokia 9110 Communicator.

The Install/Remove icon accesses PC Suite’s
Install/Remove component, which can install
software to, and remove software from, your Nokia
9110 Communicator’s main memory or memory
card..

The File Transfer icon displays a Windows
Explorer-type dialogue that lets you cut, copy,
paste, and move files between your communicator
and your PC.
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The Preferences Dialogue

Selecting the Preferences command from the PC Suite Options
menu displays the Preferences dialogue. Before using PC Suite,
make sure the settings in this dialogue are configured correctly.

¢ Select the radio button labelled Serial Cable if you are using
a serial cable to connect your communicator to your PC.

¢ Select Infrared if you are using infrared communication.

¢ The Communications Port sctting specifies the COM port
you are using to connect your communicator to your PC. If
you are using infrared, make sure you specify the port that is
assigned for infrared connection.
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Communicator Recognition

PC Suite functions allow you to configure operations—for
example, Backup and Intellisync Synchronisations—for
multiple communicators.

Because each Nokia 9110 Communicator has a unique ID
number, PC Suite for Nokia 9110 Communicator has the ability
to recognise individual communicators when they are connected
to your PC.

To configure an operation for a particular communicator, you
simply connect the communicator to your PC (or establish an
infrared connection) and configure an operation. Thereafter,
any time you connect that communicator and give a PC Suite
command to run a configured operation, PC Suite recognises
the communicator and runs the operation defined for that
communicator.

Naming your Communicator

The very first time you connect a particular communicator to
your PC—whether by serial cable or via infrared—PC Suite
asks you for a Name to associate with the communicator.
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Assigning a name to each communicator allows PC Suite to
associate each communicator (and the operations that are
configured for that communicator) with a value that is more
easily recognised than the communicator’s ID number.

Pressing the View button in this prompt displays the
“Registered Communicators” dialogue, which lists the
communicators, if any, that have been connected and named.

This dialogue can be used to rename a communicator, or delete
a communicator from the list of recognised communicators.

Deleting a

communicator » : !

name in this | ARER030
) o T ARBTIOYE

dialogue deletes all ALETEN0E

files and settings
associated with
that communicator.

Note: The Registered Communicators dialogue can also be
accessed from the Options menu.
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Refer to “The
Preferences
Dialogue” in this
chapter for
information on the
PC Suite COM port
setting.

PC Suite data transfer operations can occur via serial cable or
infrared connection.

To prepare your communicator for a data transfer via serial
cable: Connect your serial cable to your communicator and to
the appropriate PC COM port. If you are using a desk stand,
place your communicator in its desk stand with the desk stand
serial cable connected to your PC COM port.

To prepare your communicator for a data transfer via
infrared: Press the System button on your communicator. Select
IR activation on the System menu. Then point your
communicator at your PC infrared port or adapter.

Desk Stand Button Settings

If you use a desk stand, you can program the desk stand @
synchronisation button to run the currently configured Backup
and/or Synchronise operation whenever the program is active.

Click Desk Stand Button Settings in the Options menu to
display the following dialogue:
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This dialogue contains check boxes labelled Backup and
Synchronise. Neither is checked by default.

¢ Check Backup if you want the desk stand synchronisation
button to run the currently configured Backup operation.

¢ Check Synchronise if you want the desk stand
synchronisation button to run the currently configured
Intellisync operation.

If you check both Backup and Synchronise, both operations
are performed when you click the desk stand synchronisation
button, with the Backup operation occurring first.

Click OK to save your selection(s) and exit the dialogue.
Clicking Cancel exits the dialogue without saving.
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Chapter 2 :

The Contacts Application

PC Quite for Nokia 9110 Communicator’s
Contacts component lets you create, edit, and
update contact cards like those on your Nokia
9110 Communicator, and transfer them between
your PC and your communicator.

Topics in this chapter include:

¢ Using the Contacts Application

¢ The Contacts Main Screen

¢ Opening and Saving a Database

¢ Creating a Contact Card Template

¢ Adding Contact Cards

¢ Card Menu Commands

+ Editing Contact Cards

¢ Editing Contact Card Fields

¢ Adding Pictures to Contact Cards

¢ Creating and Editing Contact Groups

¢ Finding and Filtering Contact Information
¢ Importing Records from Another Database
¢ Updating to your Communicator

¢ Updating from your Communicator

¢ Synchronising your Contacts

¢ Contacts Menu Commands

Page 13

Verizon Wireless
Exhibit 1082-0267






The Contacts Application

When you save a
database, attached
JPG and .BMP
image files are saved
in a sub-directory.
(Both .JPG and .BMP
images saved in this
sub-directory are
converted to 16 bit
grey scale JPEG
format files.)

Changing the Contact
card template does
not affect the form of
existing cards.

Note that menu
options are
sometimes disabled in
the Field menu. For
example, when the
Name field is
selected, Change
Label and Delete are
not available because
you are not allowed to
delete or rename the
Name field.

Opening and Saving a Database

To create a new Contacts database, or open an existing
database, click Open on the File menu and specify a database
name and location. Use File/Save or File/Save As to save the
current database.

g a Contact Card Template

Before you start creating Contact cards, you may want to alter
the default Contact card template.

Follow these steps to create a template for the Contact cards you
will create in Contacts:

1. Open the Card menu at the top of the Contacts main
screen, and select Template to display the default Contact
card template.

Name: Card template
Company:
Jobh title:

Address:
Tel (GSM):
Fax:

Fax (GSM):
Mail:

Note:

URL:
Password:
Member:

2. In this template, you can add fields, rename fields, or
delete fields from the default template. Simply select a field
in the template and open the Field menu.

Field menu options include Change Label, Add, and
Delete.

When the template is as you want it, you are ready to add new
Contact cards to Contacts.
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Adding Contact Cards

Follow these steps to create a new Contact card:
1. Click Card to open the Card menu.

2. Click New. This displays an empty Contact card (based on
the current template) in the top window.

3. Fill out the card. Use the Enter key or up and down arrow
keys to move between fields in the card template. (Note
that as soon as you enter a Name value and move to
another field, the new Contact card appears in the lower
window.

4. Repeat these steps for each card you want to create.

5. To save the new cards you’'ve created, use the File/Save
command.

nds

\\Mmuu

Card Menu Comm

As described, the Template and New commands on the
Contacts Card menu let you create a Contact card template and
create new cards using the current template.

The complete set of Card menu commands is as follows:
¢ New: Lets you create a new Contact card.

¢ Delete: Deletes the open Contact card, or the Contact card
selected in the Contacts directory portion of the screen.

¢ Duplicate: Copies the currently selected Contact card.

¢ Copy Contents: Copies the contents of the currently
selected card to the Windows clipboard.

¢+ Template: Displays the current Contact card template.
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Editing Contact Cards

Editing Contacts cards in the Contacts application is easy.
Simply select the card you want to edit, select the field whose
value you want to change, and re-type the value.

You can also use the Field menu to edit the fields list for a
particular card. Field menu commands include Change Label,
Add, and Delete.

Changing a Field Label

The Change Label command on the Field menu lets you
change the current field label to a label selected in a displayed
list.

Note the text entry field at the lower right corner of list box.
Typing a value here adds a parenthetical to the value selected in
the list.

When you've specified the field label you want to use, click OK
to redisplay the Contact card.
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See “The Add Field
Labels List,” next, for
more information on
the list of fields that
you can select.

Note that you cannot change some field labels (e.g., Name,
Company). When such fields are selected, the Change Label
menu option is disabled.

Adding aField

The Add command on the Field menu lets you add fields to the
open Contact card. When you give the Add command, a list of

fields displays.

Add field label E3

Note the text entry box at the lower right corner of the Add
field dialogue. Typing a value here adds a parenthetical value to
the field selected in the list—for example, Address (Business).

Once you’ve selected a field in this list, click OK to add the
field to the open Contact card. Clicking Cancel exits without
adding a field.
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The Add Field List
The Add Field List contains the following fields:

The name of the company where the contact works.
Job title The job title of the contact.
The address of the contact.

The telephone number of the contact.

— The fax number of the contact.

Tel/Fax If the contact has one phone number for both the
telephone and the fax machine, write the number
here.

The e-mail address of the contact.
DIMF The DTMF (dial tone message format) string
needed for communicating with the contact.

Note You can add important information such as
birthday or office hours in this field.

The WWW address of the contact.

URL
The calendar booking password of the contact.

Ringing tone The individual ringing tone set for the contact in
the Nokia 9110 Communicator. Note that if you set
an individual ringing tone to one that does not
exist on the communicator, the default tone is
played.

— The group(s) in which the contact is a member.

Deletinga Field

To delete a field from the open Contact card, highlight the field
and give the File/Delete command.
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Adding Pictures to Contact Cards

The Contacts application lets you add pictures to your Contact
cards. A picture must first be stored on the PC in the .JPG or
.BMP format.

To add a picture to the open Contact card, click on the picture
frame at the upper right corner of the Contact card, or click
Image and select Add. This displays a Choose Image dialogue.

Choose image

Lookin [ Tem =

Jason Michagls
testuger. CFG

= |Image filez [*.bmp."jpg)

In this dialogue, use standard Windows file location methods to
find the file containing the picture you want to use. To select
the picture file, highlight the filename and click Open. Then
click OK to add the picture to the card.

If you want to add just a section of a picture to the card, use
your mouse to select a rectangular portion of the picture before
clicking the OK button.

Removing Pictures from Contacts Cards

To remove a picture from the opened contact card, click Image
and select Delete.
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By default, Contact cards have a Member field. This field
allows you to specify a group that the contact belongs to.

When you place the cursor in the Member field, a Select Group
dialogue is displayed, listing the groups that are currently
defined. To select from this list, highlight a group name and
click OK.

To add to or change the Contact Group list, open the Groups
menu and select Edit. This displays the Contact Group

Contact groups x|

| Public Relations

dialogue.

¢ To add a new group to this list: Click the New button and
type a new Group name when prompted. Then click OK.

+ To assign a group in this list to the open Contact card:
Highlight the group name and click Select.
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¢ To remove a group from the Contact Group list:
Highlight the Group name and click Delete.

The Contacts application’s Tools menu contains commands
that let you find and filter Contacts information.

Finding a Contact

To quickly find a Contact card, you can search for any text
string using the Find command on the Tools menu.

Open the Tools menu and click Find. Then enter a string to be
searched for.

When the string is located, the cards are resorted, and the
Contact card containing the string is moved to the top of the list
and displayed. If the string occurs in more than one card,
additional cards containing the specified string are listed
immediately below the displayed card.

Getting Contact I nformation

Giving the Contact info command on the Tools menu displays
a dialogue containing general information about the currently
open database—e.g., the number of records, the number of
defined groups, etc.

Page 22

Verizon Wireless
Exhibit 1082-0276



The Contacts Application

The text field is
case insensitive;
that is, capital
and lower-case
letters are
treated equally.

Filtering Contacts into a New Database

The Filter command on the Tools menu is an efficient and
versatile tool for filtering contacts from a large database into
another database.

You can create search criteria row by row, and you can control
the relationships between the criteria with the logical operators
AND, OR, and NOT, and with parentheses. You can add as
many search criteria as you want.

Search Criteria
At its simplest, a search criterion can be as follows:

Field = text

To create a search criterion, you select the name of a Contact
card field from the Field list, and type in some text. For
example:

Company = Bankers Ltd.

With this search criterion, all Contact cards that have Bankers
Ltd. in the Company field would be fetched from the database.

You can also add wildcards (?) and (*) into the text criterion.
? corresponds to any single character. For example:
Name = ?im

finds all Contact cards in which the Name field begins with any
character and ends with im (i.e. Kim, Tim, etc.).

* corresponds to any string of characters. For example:
Company = Bank*

searches for Contact cards in which the Company field begins
with Bank (i.e. Bankers Ltd., Banking, BankSaving).

Page 23

Verizon Wireless
Exhibit 1082-0277



PC Suite for Nokia 9110 Communicator

You can also select an asterisk (*) as the Contact field. For
example:

* = Bank*

finds Contact cards in which any field begins with Bank.

The logical operators NOT, AND, and OR allow you to create
more complex filters.

¢ NOT negates the search criterion. For example:
NOT Company = Bankers Ltd.

searches for all Contact cards in which the Company is not
Bankers Ltd.

¢ AND joins two search criteria together, so that both of
them apply to the search. For example:

Name = James
AND Company = Bankers Ltd.

finds all Contact cards in which the Name is James and the
Company is Bankers Ltd.

¢ ORjoins two search criteria together, but only one of them
needs to be true for a Contact card to be selected. For
example:

Name = James
OR Company = Bankers Ltd.

searches for Contact cards in which the Name is James or
the Company is Bankers Ltd.
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Using Parentheses

Using parentheses, you can combine search criteria. For
example:

Name = James
AND (Company = Bankers Ltd. OR Company = Global Air)

finds all the contacts named James who work either for Bankers
or Global Air.

Note: The closing parenthesis is selected in the input field
located on the far right of the Filter contacts dialogue. Note.

however that it only becomes available when a starting
parenthesis is sclected.

To Use Filtering

When you open the Filter contacts dialogue, the first row gives
an example of a search criterion:

Name = *

This matches all Name fields in the database. Edit this sample
criterion using the following steps. Then add additional criteria
as needed.

To edit or create a criterion:

1. If necessary, select a logical operator on the far left. In the

Parentheses can be first row, you can only select NOT.

added to filters using
the second and last

input fields. 2. Inthe Ficld column, select a field or a wildcard character.

3. Enter text (and/or wildcards) in the text input field.

To create new search criteria, use the Insert key. Remove
existing ones with the Delete key.
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Executing the Filter

The open database is the source file from which records will be
filtered. To open a different database, click the Browse button
and select a new file.

Click the Filter button to perform the filtering operation. When
the filtering is complete, the results, displayed in a separate
window, can be saved.

Note that if you save the filtered records to an existing file, the
contents of the file are overwritten (you are prompted to
confirm the overwrite).

Note: Pictures ( JPG or BMP files) are saved in a Contact
images subfolder of the database you save.

The Contacts application lets you add records from one
Contacts database into another. Simply give the Import from
file command on the File menu and specify a file. The records
(including images) in the file you choose will be added to the
open database.
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Refer to
“Synchronising Your
Contacts’ later in
this chapter for more
information on how
the “Update”
commands work.

Updating to your Communicator

The Contacts application’s File/Update to Communicator
command updates your communicator with records from the
open database. That is, records in the open database that are not
already contained in your communicator are added to the
communicator.

Follow these steps:

1. Start Contacts and open the Contacts database that contains
the records you want transferred to your communicator.

2. Connect your communicator to your PC COM port or
establish an infrared connection.

If you’re prompted to do so, enter a name for your
communicator.

3. Open the File menu and click Update to Communicator.

The Contacts application’s File/Update from Communicator
command updates the open Contacts database with records
from your communicator. That is, records in your
communicator that are not already contained in the open
database are added to the database.

Follow these steps:

1. Start Contacts and open the database that you want
updated.

2. Connect your communicator to your PC COM port or
establish an infrared connection. If you’re prompted to do
so, enter a name for your communicator.

3. Open the File menu and click Update from
Communicator.
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Synchronising your Contacts

If you were to give the Update to Communicator and Update
From Communicator commands one after the other, ecach of
your systems would contain the same set of Contact records.
However, synchronising records in this fashion can result in the
creation of “duplicate” records.

Why? During the updating process, records in your two systems
are compared. If a record in the system you are updating from is
not identical, field for field, to a record in the other system, it is
transferred. This means, for example, that if each of your
systems has a Contact card for John Johansen, but the phone
numbers in the two cards are different, a duplicate card
(containing a different phone number) is created in the target
system when you give the “Update” command.

If you want to synchronise your Contact records and avoid the
possibility of creating duplicate records, use the Intellisync
synchronisation function described in Chapter 3.
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Contacts Menu Commands

FILE

Open Opens a Contacts database.

Save Saves the open database.

Save As Saves the open database to a given
location.

Import from file Imports records from another file into the
open database.

Update to Updates communicator with records in the

communicator open database.

Update from Updates the open database with Contact

communicator records from your communicator.

Exit Exits PC Suite.

Status Bar Toggles status bar on and off.

CARD

New Creates a new Contact card.

Delete Deletes the open Contact card.

Duplicate Copiesthe open Contact card.

Copy Contacts Copies the contents of the open card to
the Windows Clipboard.

Template Lets you change the default Contact card
template.
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Change label Lets you change the selected field
label.

Add Lets you add a field to the open
Contact card.

Delete Deletes the field selected in the open
Contact card.

IMAGE

Add Lets you add a pictureto the open
Contact card.
Delete Deletes the picture fromthe open card.

GROUPS

Edit

Lets you edit the Groups list.

Find

Lets you find a Contact card containing a
given string.

Contact Info

Shows you how much data is in the open
database.

Filter Contacts

Lets you conduct an advanced search of
the open database, and save “ matching”
records to another database.
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COMPONENTS

Contacts

Sarts Contacts application component.

Intellisync

Accesses | ntellisync component.

File Transfer

Accesses File Transfer component.

Backup/Restore Accesses Backup/Restore component.
Install/Remove Accesses |nstall/Remove component.
Import/Export Accesses | mport/Export component.

OPTIONS

Desk Stand Button Displays desk stand button options.
Settings

Registered Lists the communicators that have
Communicators been connected and named.
Preferences Displays the Preferences Dialogue.
HELE

Contents Displays on-line Help Contents.
Commands Displays command information.
Using Help Accesses Help for on-line Help.
About PC Suite Displays “ About PC Suite” dialogue.
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Chapter 3 :

Intellisync

Intellisync’s Synchronisation function compares
records in your Nokia 9110 Communicator to
records in your PC application. It then makes
whatever changes are necessary in each systemto
ensure that each contains the same up-to-date
information.

This chapter explains how Intellisync works, and
guides you, step-by-step, through the process of
running your first synchronisation.

Sections include:

¢ Quick Start Tutorial

¢ Intellisync Advanced Settings Dialogues
¢ Intellisync Special Topics

¢ Intellisync Glossary

¢ Intellisync Menu Commands
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Quick Start Tutorial

Refer to
“Synchronisation
and History Files”
under “Intellisync
Special Topics” for
information on how
synchronisation is
achieved.

See “Importing and
Exporting Data” in
“Intellisync Special
Topics” for
information specific
to Intellisync Import
and Export
operations.

Refer to
“Communicator
Recognition” in
Chapter 1 for
information on how
you can use PC
Suite for Nokia 9110
Communicator with
multiple
communicators.

This “Quick Start” tutorial describes the most basic Intellisync
dialogues, and guides you through the process of setting up and
running your first Intellisync synchronisation. For information
about Intellisync “Advanced Settings,” refer to “Intellisync
Advanced Settings Dialogues™ later in this chapter.

Note: For simplicity, this tutorial emphasises synchronisation.
However, the steps shown here can also be used to configure

Intellisync imports and exports of data. The only difference is in
the choice of a button in the Intellisync Choose Translator
dialogue.

Synchronising Data

Intellisync is designed to simplify the synchronisation of data
between your communicator and your PC. Synchronisation can
be accomplished with little more than the press of a button.
Before you can execute an operation for the first time, however,
you must configure the operation you want to perform.

Once you have set up your configuration parameters for a
particular communicator, you never need to configure again
unless you want to change the nature of the operation.
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5. You may be presented with a dialogue containing the tabs
Format and File. This dialogue only displays the first time
you configure an operation for a particular communicator.
(Thereafter you can change settings in this dialogue using

Refer to *Address the Contacts command on the Options menu.)

Formats” under

“Intellisync Special + In the Format tab, select the address format that you are
Topics” for complete using for addresses in your communicator (see margin
information on note)

selecting an Address '

Format—including + In the File tab, indicate if you want to synchronise

what you should do if Contacts on the communicator’s main memory, or on

none of the formats

correspond to the

formatting of your

data. When you’ve made your selections, click OK to display the
Configuration dialogue.

the Memory card. If you choose the latter, specify the
file you want synchronised.

The Configuration dialogue contains an “Applications” list
containing your communicator’s Calendar, Contacts, and To-do
list applications.

6. Click on the Nokia 9110 Communicator application you
want to configure.

7. Click Choose to enter the Choose Translator dialogue.
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This dialogue lists all the PC applications that are compatible
with the Nokia 9110 Communicator application you selected.

When it's present,
checking the Apply to
all applications check
box at the bottom of the
Choose Translator
dialogue configures all
compatible Nokia 9110
Communicator
“applications” with the
PC application and file
you selected. If all of
the data you want
synchronised is in a
single file or folder,
check this option to
configure all of your
communicator’s
applications at once. 8.

Specify the application and (if necessary) the file you want to
synchronise. (Use the Browse button for file selection to
avoid making typos when typing in complicated paths.)

Notes:

e [f you are synchronising with Outlook, you will specify a

For information folder instead of a file. Use the Browse button for folder

about Options

selection,
dialogue settings, = .
click the Help button If you are synchronising with Schedule+ 7.0, you must
and refer to the select Schedulet Default (vou do not need to specify a file,
Supported Systems the open or last used file is used by default). If you are
on-line Help topic for using Schedule+ 7.0a or 7.5, you can select either
the PC application Schedule+ Default or Schedule+ Browse File. However,

you are using. if you want to select a file, you must sclect Schedule+
Browse File. Otherwise the open or last used file is
selected automatically,
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9. If necessary, select the operation you want to perform.
Synchronise is normally selected by default. (Synchronise is
not supported for ASCII - Text Delimited.)

10. If the Options button is enabled, click it. This accesses
special application-specific settings that apply to the selected
PC application. If necessary, adjust settings in the Options
dialogue. Then click OK.

11. Click the OK button in the Choose Translator dialogue to
return to the Configuration dialogue.

L PC Suite For Nokia: 9110 Communicator Configuration E

Now the PC application you selected appears next to the
communicator’s application name, and a two-way arrow
appears between the application names. (A one-way arrow
appears if you selected Import or Export.)

Note the check box adjacent to the highlighted applications. By
default, this box is checked, indicating that the data is activated
for synchronisation. (If you un-check this box, the data will not
be synchronised.)
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If you use a desk
stand with your
communicator, refer
to “Desk Stand Button
Settings” in Chapter 1
for information on
how you can program
your desk stand
synchronisation
button to execute the
currently configured
Intellisync operation.

Intellisync History Files

For each set of data you synchronise, a history file is used to
determine the changes that must be made in each of your
systems in order (o achieve synchronisation. This file is created
by the first synchronisation of the data. Therefore, a "first- run®
synchronisation is different from (and may take longer than)
subsequent synchronisations. A first-run synchronisation simply
merges the contents of your two systems. The Conflict
Resolution setting in the Advanced Settings dialogue is used to
resolve conflicts between the systems.

See “The Conflict Resolution Tab” under “Intellisync Advanced
Settings Dialogues” for information on the Conflict Resolution
setting.

For information on how history files are used in the process of
synchronisation, see * Synchronisation and History Files” under
“ Intellisync Special Topics.”

Re-Running the Operation

Now that you have configured a synchronisation, re-executing
the operation is basically a one-step operation. To re-run the
operation, simply prepare your communicator for
synchronisation and click the Synchronise button on the
Intellisync opening screen.

&

Taskbar Synchronisation

To run a synchronisation from the taskbar, simply click on the
program icon on the taskbar, press the right mouse button, and
select Synchronise from the pop-up menu.
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Synchronisation Notes:

e Refer to "The Filters Tab” under “Intellisync Advanced
Settings Dialogues” for information about filtering records
for synchronisation.

During Intellisync transfers of data between your
communicator and the Contacts application, pictures
attached to Contacts cards are ignored. Use PC Suite File
Transfer commands to transfer JPG and BMP files between
your communicator and PC.

Some PC applications have to be running during
synchronisations. If you are synchronising with one of these
applications, you may see Intellisync open the application
during the operation. (Refer to the Supported Systems
section of on-line Help for information about whether or not
the system you re using needs to be open or closed during
data transfers)

Data can be transferred between records in your
communicator and your PC applications because fields in the
two systems are “mapped” (linked). Intellisync provides
default “ficld mapping.” but vou may want to alter mapping
to re-direct (or prevent) the flow of data. Refer to “The Field
Mapping Dialogue” under " Intellisync Advanced Settings
Dialogues” for complete information.

Once you have synchronised a particular set of data,
changing ficld mapping causes the next synchronisation of
that data to be, in effect, a first-run synchronisation. Refer to
“Intellisync History Files” and “Synchronisation and Histoty
Files in this chapter for an explanation of first-run
synchronisations.

‘When you synchronise a Nokia 9110 Communicator
application. it is automatically synchronised with all sections
in the selected PC application that are compatible with that
application.

For information about how to perform synchronisations
remotely, see “Remote Synchronisation” under “Intellisync
Special Topics.”
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Intellisync Advanced Settings Dialogues

Refer to the Quick Start
Tutorial for information
on the Intellisync
Configuration and
Choose Translator
dialogues.

Clicking the OK button
in this dialogue saves
the current setting and
exits the dialogue.
Clicking Apply saves
without exiting.

When you run a synchronisation, the operation is affected by
settings contained in a set of Intellisync “Advanced Settings™

dialogues. This section describes these dialogues.
Topics include:
¢ Advanced Settings Tabs

¢ The Field Mapping Dialogue

Advanced Settings Tabs

When you click the Advanced button in the Intellisync

Configuration dialogue, the tabbed Advanced Settings dialogue
for the selected Nokia 9110 Communicator application appears.
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If a setting doesn’t apply
to the Nokia 9110
Communicator
application currently
selected in the
Configuration dialogue, it
is not presented. For
example, when the
Contacts application is
selected, neither the Date
Range nor the To-do List
tabs are displayed.

The tabs in this dialogue contains the following settings and
features:

*

Date Range: Determines the range of Date Book items to be
included in the operation.

To-do List: Determines if all To-do items, or only pending
To-do items will be included in the operation.

Confirmation: Determines when and if a confirmation
prompt will appear before a synchronisation takes place.

Conflict Resolution: Determines how data conflicts will be
resolved if they are detected during a synchronisation.

Filters: Lets you create filters that exclude some records
from synchronisation (or import/export).

The Date Range Tab

The Date Range setting in this tab determines the range of
Calendar items that will be included in a data transfer.
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You are presented with three options in this dialogue:

¢ Transfer All Scheduled Items: Transfers all dated items.
¢ Transfer Only Future Items: Transfers only future items.

¢ Transfer Items Within a Range of Days: Transfers items
within a specified number of days before and after “today.”

® To select an option, click on the radio button next to the one
you want.

# If you select the Transfer items with a Range of Days
option, enter numbers in the boxes labelled Days prior to
today and Days after today.

Notes:

e The “Range of Days” option allows you to create a relative
date range that automatically moves with time. For
example, if you have selected the range 30 days prior to
today. and 30 days after today. the two month range
adjusts itself automatically. That is. as today moves
forward in time. so does the relative date range.

When you run a synchronisation, records that were
included in the previous synchronisation will be
synchronised whether or not they fall within the currently
specified date range. (Intellisync identifics these ifems by
looking at the history file for the previous synchronisation).
Note, however, that only those items that fall within the
currently specified date range will be included in the
update of the history file (and therefore synchronised
during the next synchronisation of the data).
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TheTo-doList Tab

The To-do setting in this tab determines whether all To-do list
items or only pending To-do list items will be included in an
operation.

Transfer All Items is
the default setting at
installation.

* If you select Transfer All Items, all To-do list items,
including those marked “completed,” will be included in the
operation.

* If you select Transfer only Pending Items, To-do list
items that are marked “completed” will not be included in
the operation.
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Confirmation prompts
are only displayed
during
synchronisations.
They do not appear
during Intellisync
imports or exports of
data.

At installation, both
options are

selected.
Un-checking Confirm
Record Deletions is
not recommended.

The Confirmation Tab

Before the results of a synchronisation are applied, you may be
prompted to confirm the operation. The confirmation prompt—
which lets you proceed with or cancel the operation, display
details about what will occur, or execute a “full re-
synchronisation”—is a safeguard against accidentally
modifying or deleting the wrong data.

The setting in the Confirmation tab determines the conditions
under which a confirmation dialogue appears.

Two options are presented: Confirm Record Deletions and
Confirm Record Changes.

Either, both, or neither can be selected.
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*  When Confirm Record Deletions is checked, the prompt
appears if a synchronisation will result in the deletion of
records.

* When Confirm Record Changes is checked, the prompt
appears any time a synchronisation will add or change
records.

®* If neither of these options is checked, a confirmation prompt
will only appear if the operation will result in the deletion of
all records from a system.

This is a typical confirmation prompt:

A separate
confirmation
prompt is displayed
for each Nokia
9110
Communicator
application you are
synchronising.

Note the five buttons at the bottom of the Confirmation
prompt:

B Accept: Accepts the set of changes shown and continues the
synchronisation.

B Cancel: Cancels the synchronisation.
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Refer to “Full Re-
Synchronisation” in
“Intellisync Special
Topics” for information
on full re-
synchronisation.

B Details: Displays a “Details” dialogue box showing a
detailed description of what will occur if the synchronisation
proceeds.

B Re-sync: Performs a full re-synchronisation—in effect, a
“first -run” synchronisation.

B Help: Opens the Intellisync on-line Help system.

The Details Dialogue

The confirmation prompt that may appear before a
synchronisation takes place contains a Details button. Use this
button when you want to review the exact actions that will
occur if the synchronisation proceeds.

‘1 Details for Confirm Calendar Changes
any operation bo cee more detailz.

g will be applied o Lotus Urganizer

| Operstion [ Dese [ StatDate | Stait Time | EndDate| End Time | Hepests |

thiz iz a... 2/27/38

g will bee applied to Nokja 9110 Communic

thizisa... 2/27/98
3/4/98 1200 AM
multi day 344/98

Close l

The Details dialogue contains a field-by-field representation of
each of the records that will be affected by the synchronisation
and, for each, notes the operation that will take place (Add,
Change, Delete).
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If changes will occur in both of your applications, a separate
area of the dialogue will be shown for each.

The operation that will take place for each record is indicated in
the first column of the Details dialogue.

To see more details about any single record, double click on the
operation for that record. This displays an “Additional Details”
dialogue.

w4y Additional Details for Confirm Calendar Changes

The following record will be changed in Mokia 9110 Communicator

Note that both the Start date varnes varies
P Start time 8:30 AM 2:30AM

original and the new Firish 5:30 AM 530 8M

values are represented # Alam g

. . . AlarmFlag No Ma

in this dialogue. Text NOK18 NOK18

Repeats Weekly wieskly

First Date 141800 1418700

Lagt Date Open-ended Open-ended
? Excluded Dates  Mone 2429700

Notes:

e Details dialogues can be resized When vou resize a
dialogue. the position and size is remembered the next time
you display a Details dialogue.

Data in ~ Additional Details” dialogues can be sorted. in
either ascending or descending order. by double clicking on

the column heading (clicking the same column heading
again sorts the column in the opposite order).

To see the full contents of a field whose value is truncated
in the Additional Details dialogue, double click on the field
name. For a changed item, both the former and new values
are displayed.
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To specify a Conflict
Resolution setting,
select the radio button
next to the option you
want.

Notify me when
conflicts occur is the
default setting.

The Conflict Resolution Tab

When a data conflict occurs during a data transfer, and
Intellisync can’t resolve it using the normal synchronisation
process, the Conflict Resolution setting selected in this tab is
used to resolve it.

What is a Data Conflict?

A data conflict exists when records in your two systems that
should be equivalent contain conflicting data in one or more
mapped fields.

More specifically, a data conflict exists when two records
contain the same key field values, but different values in other
mapped fields.
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Refer to “Field
Mapping and
Freeform Fields”
under “The Field
Mapping Dialogue”
for information on
how Intellisync
interprets your
communicator's
Name field.

Refer to
“Synchronisation
and History Files”
under “Intellisync
Special Topics” for
information on first-
run
synchronisations.
See “Full Re-
Synchronisation” in
Intellisync Special
Topics for details
on full re-
synchronisation.

Key Fields

Fields designated as “key” are those that are the most
fundamental to a particular record. For example, First Name
and Last Name fields are key fields in Contacts records.

The use of key fields in detecting data conflicts is premised
on the following: When key fields in a Nokia record match the
key fields in a PC application record, other mapped fields in the
two records should also match. In other words, if both of your
systems have an address record for Ron Ogg, the values in
Title. Company. etc. should match. If they do not. a data
conflict exists.

Note: Letter case counts in key fields. If vou have a record for
Diana VanWinkle in vour PC application. and one for Diana
Vanwinkle in your communicator, Intellisync does not recognise
the names (or. therefore. the records) as equivalent.
Synchronisation causes both records to occur in each system.

See Key Fields in on-line Help for information about which
ficlds are key fields for each data type.

The occasions when the Conflict Resolution setting is needed to
resolve data conflicts are as follows:

*

*

*

First-run and full-re-synchronisations.
Imports and Exports of data.

When new records have been added to each system since the
last synchronisation, and those records conflict. (For
example, if you have added an address record for Brian
Sawyer to each of your systems, but the Company fields
don’t match.)

When mapped fields have been edited in both systems since
the last synchronisation, but edited differently. (For example,
if you have updated Brian’s home phone number in both
records, but made a typographical error in one of them.)
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Notify me when
conflicts occur is the
default setting.

See “The Conflict
Resolution Dialogue
Box,” below, for
more information
about the Notify
setting.

Note the check box
labelled “Apply to all
conflicts.” If you
check this box, the
action you choose in
this dialogue will be
automatically applied
to any other conflicts
detected for the
current Nokia 9110
Communicator
application.

Conflict Resolution options work as follows:

*

Add all conflicting items: Adds a new record to each
system (or, for one-way transfers, to the target system). The
original conflicting records remain intact.

Ignore all conflicting items: Makes no change to either
system.

Notify me when conflicts occur: Displays a dialogue box
each time a data conflict occurs, letting you decide which
data to use on a case-by-case basis.

Nokia 9110 Communicator Wins: Uses data from your
communicator when conflicts occur. Use this option when
your communicator contains the most current information.

Other Application Wins: Uses PC data when conflicts
occur. Use this option when your PC application contains
the most current information.

The Conflict Resolution Dialogue Box

When Notify is the Conflict Resolution setting, a dialogue is
presented each time Intellisync needs help resolving a conflict.
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The Conflict Resolution dialogue shows the conflicting fields
from both systems. The field name is displayed in the left
column. The PC application’s field value is in the centre, and
the Nokia 9110 Communicator application’s field value is on
the right.

A box at the top labelled “Item” contains a key field value.
This helps to identify the conflicting record.

If a record in one system conflicts with more than one record in
the other system, the box to the right of the Item box will say 1
of 2, or 1 of 3, (etc.), and left and right arrow controls will let
you switch between conflicts.

To resolve a conflict in the Conflict Resolution dialogue box,
you can select one of the following options from the list box
below the grid: Add, Ignore, Update, or Replace (Import/Export
only).

¢ Add: Adds a new record to each system (or, for one-way
data transfers, to the target system). The original
conflicting records remain intact.

¢ Ignore: Makes no change to either record.

¢ Replace: (Import/Export only) Replaces the target record
with a record containing mapped values from the source
record. Unmapped fields in the original record will be lost.

¢ Update: Updates one or both records (as necessary) with
the value or values you have highlighted in the grid. Use
Update instead of Replace to avoid losing un-mapped fields
in the target record.

Conflict Resolution Dialogue Buttons

The Conflict Resolution dialogue box also contains the following
four buttons:

B OK: Initiates the specified action and continues the
operation.

B Stop: Takes no action and terminates the operation.
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B View: Displays a dialogue showing the full contents of the
selected field. Use this to display complete values when
lengthy values are truncated in the Conflict Resolution
dialogue box.

B Help: Displays on-line Help text.

Conflict Resolution Notes:

o Referto "The Same Record Changed and Deleted
Dialogue” under " Intellisync Special Topics for
information about a special Conflict Resolution dialogue
that appears when a record has been deleted in one system
and changed in the other system since the last
synchronisation,

Remember: Except for “first-run” synchronisations, the
Contlict Resolution setting is not normally needed to

resolve conflicts when you're synchronising vour two
systems. In most cases, Intellisync knows how to edit
records to achieve synchronisation.

Conflict Resolution is applied individually to cach pair of
configured applications. This means that any time you
change the Conflict Resolution setting, the change will
apply only to the currently selected applications.

Since “Notify’ (the default) is the only setting that lets you
see each data contflict and decide for yourself how the
conflict should be resolved. it is the recommended setting.
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The names of the filters
you create are shown in
the Filters tab.

A pre-existing filter,
Exclude Private Data,
lets you exclude records
marked Confidential, or
Private, etc.

To activate a filter for
use, click on it (you can
only use one at a time.)
Click <None Selected> if
you do not want to apply
a filter to the next
synchronisation.

TheFilters Tab

The Filters tab of the Advanced Settings dialogue lets you “filter”
records for synchronisation, import, or export.

By default all records in the applications you configure for
synchronisation are included when you run an Intellisync
operation (unless they are excluded by the Date Range or To-do
list setting).

If you want to synchronise (or import/export) only a subset of
items, you can filter records using Intellisync’s filtering
function.

For example, the following filter instructs Intellisync to include
only address records that have a Last Name value starting with
A through M, and have the Company value of Bankers Ltd.

Last Name is between A and M AND
Company equals Bankers Ltd.
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Filters Tab Commands

The Filters tab contains the following command buttons:

When you click New, B The New button is used to create a new filter for the
you are prompted to currently selected communicator and PC applications.

name the filter before
creating it.

The Edit button lets you edit an existing filter.

The Rename button lets you rename an existing filter.

The Delete button deletes the highlighted filter.

Conditions and Rules Tabs

Clicking the New or Edit button in the Filters tab displays two
additional tabs: Conditions and Rules.

The Conditions Tab

The Conditions tab is where you specify the condition(s) that a
record must meet in order to be included in a data transfer. Each
condition consists of a Field, an Operator, and a Value.

For example, here are some conditions that could be applied to

various applications:

Field Operator

Last Name is between
Company equals
Title equals
Date is between
Start Date on or after

Value(s)

Aand G

Global Air

President

01/01/1998 and 07/01/1998
01/07/98
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The Rules Tab

The Rules tab contains options corresponding to the logical
operators AND and OR.

All Conditions must be met = AND
One or more conditions must be met = OR

Select an option in the Rules tab when you want to include more
than one condition in a filter.

Note: Only one logical operator can be applied to any given
filter. You cannot create filters that contain both AND and OR.

By combining conditions with a logical operator selected from
the Rules tab, you can create filters like the following:

Date after 11/06/97 AND
Time after 14:00

Company equals Bankers Ltd. OR
Company equals Global Air OR
Company equals Software House Ltd.

The first filter would include only records with date values after
11/15/97 and time values after 14:00. (Note that times are shown
in 24-hour format—e¢.g., 14:00 for 2 p.m.)

The second filter would include only records with a Company
value of Bankers Ltd., Global Air, or Software House Ltd.
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Creating a Filter

Follow these steps to create a filter:

1. Click the New button in the Filters tab. When prompted for
a filter name, type a name and then click OK. This displays
the Conditions dialogue.

If you want to change
the Operator or Value
entry for a condition in
this dialogue, change
the entry and click
Update. Clicking
Remove deletes the
highlighted condition.

2. Click the Field button to display the field list for the selected
PC application. Highlight the field you want to filter on.
This places it in the Field text box.

3. Sclect an operator for the condition by highlighting an
option in the Operator list box. (See below for the list of
operators you can choose from.)

4. Enter a value or values in the Value text box to complete the
condition. Then click the Add to List button to place the
condition in the Conditions List in the lower part of the
dialogue.
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Note that a logical
operator will not
appear in the
Conditions tab until
a second condition is
added.

The Boolean operators
is true and js false
are used for fields like
Completed? and
Confidential? that are
either checked or
unchecked.

is true = checked

is false = unchecked

5. To add other conditions to the filter, click the Rules tab and
select All Conditions must be met (AND) or One or more
conditions must be met (OR). Then click the Conditions tab
and specify additional conditions.

6. When the filter is complete, click OK to save it.

Conditions Tab Operators

There are four operator types that may be offered in the
Conditions tab: String, Date, Time, and Boolean. Choices
available for each type are as follows:

String Date Time Boolean
starts with equals equals is true
contains does not equal does not equal is false
does not contain  after after

equals before before

does not equal on or after on or after

is empty on or before

is not empty is between

is between today minus ?
days
today plus ?
days

on or before
is between
now minus
? minutes
now plus ?
minutes
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Filtering Notes:

o Filtering can be applied to Intellisync imports and exports as
well as synchronisations.
If you filter on a field that is not mapped, Intellisync can
filter on the PC side, but not on the communicator side. In
other words, records will be excluded from your PC
application, but not from your communicator.

If you filter on a field that is contained in only one of your
systems, the filter will only exclude records in that system.

You cannot use both AND and OR in a single filter,
However, you can use the operator is between to create
conditions like Last Name is between A and C. This. in
cffect. says "If Last Name starts with A, or Last Name starts
with B, or Last Name starts with C.” You can then use the
AND operator to create a filter like the following which, in
effect. does utilise both logical operators.

Last Name /s between A and C AND

Company equals Kennel Ltd.

If you change or select a different filter after you ve run a
synchronisation with Outlook the next svnchronisation will
be. in effect, a first-rin synchronisation.

A filter only applies to the Nokia 9110 Communicator and
PC applications that were selected in the Configuration
dialogue when the filter was created—<c.g.. Address Book,
To Do List, etc, Filters must be created separately for each
set of applications you want to synchronisec.

Clicking on a filter name in the Filters tab activates that
filter for the next synchronisation (Only one can be selected
at a time.) When a filter is active. its name appears in the
bottom right corner of the Configuration dialogue when the
application to which it applies is highlighted.

Click <None Selected> in the Filters tab if you do not want
to apply a filter vou ve created to the next synchronisation.

Page 60

Verizon Wireless
Exhibit 1082-0314






PC Suite for Nokia 9110 Communicator

* To un-map mapped fields: Click on the arrow (or highlight
the PC field name and double click or press the Spacebar).

* To map adjacent fields: Click between the fields (or
highlight the PC application field name and double click or
press the Spacebar). An arrow appears to indicate that the
fields are mapped.

®* To map non-adjacent fields: Drag the field in the right-
hand column and drop it next to the field in the left-hand
column.

®* To reinstate default field mapping: Click the Reset
button.

Field Mapping Dialogue Buttons

The buttons at the bottom of the Field Mapping dialogue work as
follows:

B OK: Saves changes made to field mapping and re-displays
the previous Advanced Settings dialogue.

B Cancel: Cancels changes made to field mapping.

B Help: Opens the Intellisync on-line Help system.

B Reset: Resets field mapping to the installation default
configuration.
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Field Mapping Notes:

o Intellisync enforces certain ficld mapping rules. For
example. you cannot map date fields to time fields. If you
attempt to map incompatible field types, an error message
is displayed.

If you change field mapping after data has been
synchronised, the subsequent synchronisation will be, in
effect. a first-run synchronisation.

Fields marked with asterisks in the Field Mapping
dialogue are ficlds that must be mapped (or their sub-ficlds
must be mapped) in order for a data transfer to succeed. If
marked fields are not mapped, an error message is
displayed when you attempt to exit the Field Mapping

dialogue.

Check the Supported Systems on-line Help topic for the PC
application(s) you re using to sce if any special field
mapping rules apply. (For example, if your application
allows for the creation of custom fields, the Help topic for
that system should tell vou how to map custom ficlds.)

When a data string is transferred between fields in your
communicator and your PC application, it may be
truncated in the target field if it is too lengthy to be
accommodated. It is not wise to edit truncated data. If vou
do. the data in the other system will be truncated after the
next synchronisation. Refer to “"Synchronisation and Data
Truncation’ under “Intellisync Special Topics” fora
workaround that allows you to edit truncated text.
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If your freeform
fields are formatted
inconsistently,
synchronisations
and exports will
result in the incorrect
placement of values
in your PC
application.

Select the address
format that most
closely resembles the
one you’re using.

Field Mapping and Freeform Fields

When Intellisync transfers Name and Address fields between
your two systems, it assumes a particular format for your
communicator’s Name and Address fields.

The default Name format is as follows:
LAST, FIRST MIDDLE

The Address format is determined by the Address Format you
select when you first configure an operation. (Refer to
“Intellisync Address Formats” under “Intellisync Special
Topics” for a description of each of the four available formats.)

If names are not entered into your communicator in the above
format, and/or if the addresses in your communicator’s
Contacts application do not match any of the available formats,
you may want to adjust the field mapping in the Field Mapping
dialogue to direct values between the correct fields.

For example, if the third line in your addresses is formatted in
this way: City, State, Postal Code, but the selected Address
format is Postal Code, City, State, the following field mapping
scheme would transfer values correctly between your
communicator and PC:

Communicator PC Application
City Postal code

State City
Postal Code State
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Intellisync Special Topics

This section is devoted to explaining in detail some aspects of Intellisync
that have only been touched upon in previous sections of this chapter.

Topics include:

¢ Synchronisation and History Files

+ Intellisync Terms

¢ Intellisync Address Formats

¢ Importing and Exporting Data

¢ Synchronisation and Truncated Data

+ Full Re-Synchronisation

¢ The Same Record Changed and Deleted Dialogue
¢+ Sync Log Files

¢ Remote Synchronisation
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An understanding of
history files and how
synchronisation
works is not
mandatory.
However, you may
find this information
helpful.

See “The Conflict
Resolution Tab”
under “Intellisync
Advanced Settings
Dialogues” for details
on Conflict
Resolution.

For additional
information about
history files, refer to
the Intellisync on-line
Help system.

Synchronisation and History Files

During a synchronisation, Intellisync compares records in your
communicator application to records in your PC application,
and makes whatever changes are necessary in each system to
ensure that both contain the same information.

If a record has been added to one system and not the other, that
record is added to the incomplete system. If a record has been
deleted from one system and not the other, Intellisync deletes
the record from the other system. If there are discrepancies
between records in the two systems, Intellisync uses the most
current data. It knows which is the most current because it uses
a “history file” when comparing the records.

The first time a particular set of data is synchronised, there is
no history file. Data from the two applications are simply
merged, and conflicts between the two systems are resolved
using a “Conflict Resolution” setting.

However, this initial operation creates the history file that will
be used for subsequent synchronisations.

How does the history file work? At the end of each
synchronisation, a history file matching the two synchronised
systems is created. When the systems are next synchronised,
Intellisync compares the two synchronised systems to each
other, and to the history file. If a record in the history file
matches one system, but not the other, Intellisync knows that
the “conflicting” record has been changed since the last
synchronisation. It therefore applies the change to the other
system and to the history file.

In cases where changes have been applied to both systems, and
those changes conflict (for example, if you have added address
records for the same name to each system, but the phone
numbers don’t match), the Conflict Resolution setting is used to
resolve the matter.
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If address data in your
communicator is not
consistently formatted,
and you have the same
basic data in your PC
application, you can
achieve consistency by
deleting the addresses
from your
communicator and
synchronising with your
PC application. This will
transfer the contents of
your PC application
back into your
communicator in the
selected Address
Format.

Before doing this,
however, it would be
wise to backup your
communicator data as
a precaution.

Intellisync Address Formats

In order for Intellisync to transfer data correctly between your
communicator and your PC application, it must assume a
particular format for freeform Name and Address fields in your
communicator’s Contacts application.

Intellisync assumes that Name fields are entered into your
communicator as follows:

Last, First Middle

When you first configure an Intellisync operation for a
particular communicator, you are prompted to select an
Address format. Address formats can also be accessed by
selecting Contacts on the Intellisync Options menu.

Intellisync offers five formats to choose from—Address Format
1, Address Format 2, and so on. If none of the formats match
the format you are using, you can either select the closest
format and adjust field mapping to account for the differences,
or choose Format 5, which transfers the communicator’s
complete Address field to a single field in your PC application.

Refer to “Field Mapping and Freeform Fields” under
“Intellisync Advanced Settings Dialogues” for additional
information on freeform Name and Address fields.

Note: In order for Intellisyne to successfully transfer data
between your two systems, data in freeform fields must be

entered 1n a consistent format. If your freeform fields have been
entered inconsistently. the results of a synchronisation, import,
or export will reflect that inconsistency.
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Available Address Formats

Address Format 1
Address Item 1, City, State, Postal Code, Country

For example: 13 Lewis St., Moose Junction, MO, 45678, USA

Address Format 2

Address Item 1 <newline>
City, State, Postal Code, Country

For example: 1312 Lewis St.
Moose Junction, MO, 45678, USA

Address Format 3

Address Line 1 <newline>
Address Line 2 <newline>
City, State Postal Code <newline>

Country

For example: 1312 Lewis St.
Suite 34
Moose Junction, MO 45678
USA
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Address Format 4

Address Line 1 <newline>
Address Line 2 <newline>
Postal Code, City, State <newline>

Country

For example: 1312 Lewis St.
Suite 34
45678, Moose Junction, MO
USA

Address Format 5

Selecting Address Format 5 is, in effect, selecting no format.
This option can be used if you have not used consistent
formatting in your communicator, or if none of the other
formats resemble the format you’re using.

When you select Address Format 5, your communicator’s
multi-line Address field is transferred to a single field in your
PC application, and vice versa. Check the Field Mapping
dialogue to see the default mapping.

Note: Using this format during synchronisations may result in
the transfer of incomplete addresses from your PC application
to your communicator,

For example when Address Format 5 1s selected Intellisyne
maps the communicator’s Address field to the Address portion
of a Schedulet address. (A complete Schedule+ address

includes Address. City. State, Postal Code. and Country.) Thus,
only the Address portion of a Schedule+ address transfers to
your Nokia 9110 Communicator. City, Sate. etc. are ignored.
In order to transfer the entire Schedule+ address to your
communicator, you would need to enter the entire address into
the Address field.
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Importing and Exporting Data

In addition to synchronising your communicator with PC
applications, Intellisync can also perform imports and exports of
data from one system to the other.

The same procedures that are involved in configuring and
performing a synchronisation are used for importing and
exporting. That is, you have to set up the Configuration and
Choose Translator dialogues, and, if necessary, adjust settings in
the Advanced Settings, Options, and Field Mapping dialogues.
Once things are set up, the Synchronise button on the Intellisync
opening screen initiates the operation. The only difference is in
the choice of the operation in the Choose Translator dialogue.

¢ To import data from your PC to your communicator, select
Import.

¢ To export data to your PC from your communicator, select
Export.

Notes:

o When vou perform an import or export. Intellisync doesn’t
duplicate records that already exist in both systems. For
example, if you export the contents your communicator’s
Contacts application to your PC, records that are already

contained in both systems are not transferred to the PC file.

In a single operation, you can perform different types of data
transfers, For example, in one operation, you can import into
your communicator’s Contacts application, export Calendar
information, and synchronise your To Do’s. It’s simply a
matter of which operation you choose for each set of data.
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When data is transferred between fields in your communicator
and your PC application, data is truncated in the target field if
the source data is too lengthy to be accommodated.

If you later edit the truncated data, the corresponding data in
your other system is truncated after the next synchronisation.
(Because Intellisync applies the detected edit to the data.)

If you want to edit truncated data, there is a workaround—as
follows:

Any time you edit truncated data, go in and edit the
corresponding record in the other system. (It can be the same
change you made in the shortened record, or a trivial edit of no
consequence. The important thing is that a change is registered
in that record). Make sure the “Notify” Conflict Resolution
setting is selected. Then, during the next synchronisation, when
the Conflict Resolution dialogue box is displayed for that
record, select Ignore. This prevents the truncated data from
overwriting the data in your other system.

Note: If you select Ignore, as recommended. you will be
prompted to resolve the conflict again the next time you run a
synchronisation. If this is not acceptable. you can highlight the

original (non-truncated) text in the Conflict Resolution
dialogue and choose Update. Note. however, that this will
overwrite the edit that caused the conflict in the first place.
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Refer to “The
Confirmation Tab”
under “Intellisync
Advanced Settings
Dialogues” for
information on the

confirmation prompt.

Full Re-Synchronisation

If, for some reason, the data in either your communicator or
your PC application is lost or unintentionally altered, do not
synchronise the data. Doing so will transfer the problem to your
other system.

For example, if all address records were accidentally deleted
from your PC application, Intellisync would see that all the
records were deleted since the last synchronisation and remove
the address records from your communicator.

Fortunately, the confirmation prompt would warn you before
such a synchronisation actually took place. In addition to
warning you, it would allow you to use the Re-Sync button to
execute a Full Re-Synchronisation.

Unlike a normal synchronisation, a full re-synchronisation
would not delete the records in your communicator. This is
because a full re-synchronisation is, in effect, a “first-run”
synchronisation. That is, the history file is thrown out, and the
synchronisation simply merges the contents of the two systems.

Notes:

o [f the data in vour communicator or PC application is not
lost. but has in some other way been corrupted, you can
delete the contents of the file and execute a full re-
svnchronisation to transfer the contents of the other system
into the empty file or application. Note. however, that only

mapped values can be transferred to the empty system.
Unmapped values will be lost from any records you delete.

The confirmation prompt is the only way to access the Re-
Sync button. It 1s therefore advisable to keep active the
Confirm Record Deletions sctting in the Advanced
Settings dialogue.
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This dialogue
appears only when
Notify me when
conflicts occur is
the selected Conflict
Resolution setting. If
any other setting is
selected, a change
will always override a
delete—that is, the
changed record will
be added to the
system from which
the record was
deleted.

If, during a synchronisation, Intellisync discovers that a
previously synchronised record has been changed in one system
and deleted in the other since the last synchronisation, a
special dialogue is displayed.

The Same Record Changed and Deleted dialogue alerts you to
the deletion of the record in one system, and shows you the
record as it has been changed in the other. A list of options
allows you to decide between the following actions:

¢ Add: Adds the item back into the system from which it was
deleted.

¢ Delete: Deletes the record from the other system.

+ Ignore: Lets each system remain as it is.
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The Sync Log file can be
a good source of
information if you call for
technical assistance.

The Sync Log file is a
simple text file that can
be viewed using any
editor.

Each time you run a
synchronisation, the file
is overwritten. If you
want to save a particular
Sync Log file, rename
the file before running
another synchronisation.
The file is located in a
sub-directory (of the
installation directory)
named after the
communicator serial
number.

A set of buttons also appear at the bottom of the dialogue.
B OK: Exits the dialogue and applies the selected action.
B Stop: Stops the synchronisation.

B View: Lets you see the complete value of the highlighted
field when it is too long to be displayed in the grid.

B Help: Calls on-line Help.

The Sync Log File

Intellisync maintains a Sync Log file that is updated after cach
data transfer. The Sync Log file contains a detailed accounting of
what occurred during the synchronisation, import, or expott.

Normally, it’s not necessary to read the Sync Log file after an
operation. However, if errors were reported, it may be a useful
source of information.

To view the Sync Log file for the last data transfer, select the
Sync Log command on the Intellisync View menu.

The file identifies the records that were transferred from one
system to the other, and indicates the exact action that was taken
for each record. Field Mapping is also shown in the Sync Log
file.

Reading a Sync Log File

Before any actions are taken during a data transfer, records from
each system are read (looked at). You will see the term READ
used in the log file to indicate this process.
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After reading records in each of the systems, Intellisync
compares the records in both systems, as indicated in a section
labelled Summary of Data Analysis. Here you will see phrases
such as: Unchanged on Both Systems, Changed on First System,
and Deleted from Second System

The next section of the Sync Log file lists the actions that were
taken in your “First System” (Nokia 9110 Communicator) and
“Second System” (PC application) during the data transfer.

Actions that may be noted in the Sync Log file are as follows:

ADD: The record was added.
DELETE: The record was deleted.

FAIL RANGE: The item was excluded from the operation. It
either failed the Date Range check for Appointments or it was a
“completed” To-do list item, and the Transfer Only Pending
Items option was checked in the To-do list tab of the Advanced
Settings dialogue.

IGNORE: The record was ignored.

SKIP: The record was skipped because the data transferred was
of a different type.

UPDATE: The record was updated with a value or values from
the other system.
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Intellisync lets you
configure and save both
a local and a remote
synchronisation for
each Nokia 9110
Communicator you
connect and “register.”

Remote Synchronisation

Intellisync allows you to configure and run “Remote™ as well as
“Local” synchronisations of Calendar data. A remote
synchronisation is a synchronisation that you can run remotely,
over a data call.

To configure a remote synchronisation, follow the “Quick Start”
instructions provided at the beginning of this chapter—only click
the Remote tab to configure the operation.

Remote vs. Local Synchronisation

When you run a synchronisation locally, you are sometimes
prompted for information. For example, if the “Notify” Conflict
Resolution setting is selected, you may be prompted to resolve
data conflicts. If your PC application requires a password, you
will be prompted to enter a password—and so forth.

Since interaction with your computer is not possible when you
run a remote synchronisation, remote synchronisations are a little
different from local ones.

Please note:

¢ When you configure a remote synchronisation, you will
notice that the Conflict Resolution tab of the Advanced
Settings dialogue does not contain the Ignore and Notify
options. (Add is the default Conflict Resolution setting.)

¢ During a synchronisation, if Intellisync discovers that the
same record has been deleted in one system and changed in
the other since the last synchronisation, the change is
applied instead of the delete.

¢ There is no Confirmation tab in the Advanced Settings
dialogue because a confirmation prompt does not display
during remote synchronisations.

¢ You cannot synchronise PC applications that require you to
type a password for access during a synchronisation.
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Refer to Chapter 9,
“Internet,” in your Nokia
9110 Communicator
manual for information
on connecting your
communicator to your
PC via the Internet.

Running a Remote Synchronisation

In order to run a remote synchronisation, you must have an
Internet access point to facilitate the remote connection to your
PC. In addition, PC Suite for Nokia 9110 Communicator must
be up and running on your PC.

Once you have configured a remote synchronisation, follow
these steps to run it from your communicator:

1. Press the System application button on your
communicator.

2. Choose Remote Synchronisation and press Select.

3. Press Settings and define the destination host (the IP
address of the server PC) and select your Internet access
point.

4. Press Start to start a data call and begin synchronising.

When the synchronisation is complete, the data call ends.
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Intellisync Glossary

Boldfaced text identifies
additional terms defined
in this section.

See “The Conflict
Resolution Tab” under
“Intellisync Advanced
Settings Dialogues” for
more information about
Conflict Resolution and
data conflicts.

Read this section to gain an understanding of some of the terms
that are used to describe PC Suite’s Intellisync function.

Conflict Re

A process (controlled by a setting in the Conflict Resolution tab
of the Advanced Settings dialogue) that is sometimes used by
Intellisync to determine how to resolve data conflicts during
synchronisations. See Data Conflict, below.

Data Conflict

A data conflict occurs when records in both systems have
matching key field values but conflicting data in other mapped
fields. (For example, if both systems have address records in
which the First and Last Name values are identical, but the
address values differ.)

The very first time a set of data is synchronised (and any time
you import or export data) the Conflict Resolution setting in the
Advanced Settings dialogue is used to resolve all such conflicts.
Upon subsequent synchronisations of the same data (after the
history file has been created), the Conflict Resolution setting is
needed only under either of the following two conditions:

1) When records with the same key fields have been added to
both systems since the last synchronisation, but they have
conflicts in other mapped fields.

2) When mapped fields in previously synchronised records
(with matching key fields) have been edited since the last
synchronisation, but edited differently.
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Fanning

The conversion of a repeating item into many individual items
(“fanned” items) having unique dates. Fanning occurs when one
of your systems does not support an incoming repeating item.

ping

The linkage that directs the comparison and transfer of data
during an Intellisync data transfer. Field mapping is contained
(and can be edited) in the Intellisync Field Mapping dialogue.

To access the Field Mapping dialogue, select the Field Mapping
button in the Advanced Settings dialogue.

Filter

A statement that can be applied to a synchronisation to restrict
the records that are included in an operation. See “The Filters
Tab” under “Advanced Settings Dialogue” for information
about using Intellisync filters.

First-Run Synchronisation
The first synchronisation of a particular set of data.

A first-run synchronisation is different from subsequent
synchronisations of the same set of data because no history file
exists. The history file is created during the first run (and the
Conflict Resolution setting is used to settle data conflicts
between the two systems.)
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Full Re-Synchronisation

A special mode of synchronisation that merges rather than
synchronises data in your two systems. (In effect, a “first-run”
synchronisation.) This is used for restoring lost data and for
maintaining data integrity when records have been altered. A full
re-synchronisation can be performed using the Re-Sync button in
the confirmation prompt that may appear before the results of a
synchronisation are applied. Refer to “The Confirmation Tab”
under “Intellisync Advanced Settings Dialogues” for more
information.

History File

A file that is created by a “first-run” synchronisation and
updated after every subsequent synchronisation. This file aids
Intellisync in determining which data to use when there are
discrepancies between your communicator and PC application.
See “Synchronisation and History Files” under “Intellisync
Special Topics” for more complete information.

Key Field

A field specially defined to detect data conflicts during a data
transfer. During a synchronisation, Intellisync compares the
values of mapped fields in your two systems. When “key” values
match, but other mapped values differ, a data conflict exists. For
example, in Contacts records, if Name (key) values match, but
Phone values differ, this is a data conflict.

Mapped Fields

Fields that are linked for data transfer in the Intellisync Field
Mapping dialogue.
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Section

A type, or category, of data contained in a PC application. For
example, Addresses, Notepad, and Schedule are sections
contained in some of the PC applications supported by
Intellisync.

The Intellisync operation that compares the records in your
communicator to the records in a PC application file, and makes
whatever changes are necessary in either system to make sure
that they both contain the same data.

Translator

A component of the Intellisync software that enables Intellisync
to transfer data between your Nokia 9110 Communicator and a
particular PC application.
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Intellisync Menu Commands

FILE

Exit

Exits PC Suite.

Status Bar

Toggles status bar on and off.

Sync Log

Displays the Sync Log for the last
Intellisync operation.

Contacts

COMPONENTS

Starts Contacts application component.

Intellisync

Accesses | ntellisync component.

File Transfer

Accesses File Transfer component.

Backup/Restore Accesses Backup/Restore component.

Install/Remove Accesses | nstall/Remove component.

Import/Export Accesses | mport/Export component.

OPTIONS

Contacts Displays Contacts Address Format and
File options.

Desk Stand Button Displays desk stand button options.

Settings

Registered Lists the communicators that have

Communicators been connected and named.

Preferences Displays the Preferences dialogue.
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HELP

Contents Displays on-line Help Contents.

Commands Displays command information.

Using Help Accesses Help for on-line Help.

Premier Upgrade Displays Intellisync registration and
Premier Upgrade subscription
information.

About PC Suite Displays “ About PC Suite’ dialogue.
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Chapter 4 : File Transfer Functions

The PC Quite File Transfer functions let you
move, copy, paste, rename, and delete Nokia
9110 Communicator and PC filesand foldersin a
familiar Windows Explorer-type environment.

Topics in this chapter include:

*

*

Using the File Transfer Functions
File Transfer Window Panes
Selecting Files

Copying Files and Folders
Moving Files and Folders
Deleting Files and Folders
Renaming Files and Folders

File Properties

File Transfer Menu Commands
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Using the File Transfer Functions

Unlike Windows
Explorer, you cannot
launch a program or
open a file from the File
Transfer screen.

The PC Suite File Transfer functions let you move, copy, paste,
rename, and delete Nokia 9110 Communicator and PC files and
folders in a familiar Windows Explorer-type environment.

Note: Built-in conversion utilities for some types of files allow
you to transfer “incompatible” files between your communicator
and your PC in a readable form. Files that are converted

include: Nokia 9110 Communicator Notes files, communicator
Fax files, and PC TIFF files (compressed in Group 3 (1d) Fax
format).

Follow these steps to access the PC Suite File Transfer functions.

1. Start PC Suite and click the File Transfer icon in the
opening screen.

2.  Connect your communicator to your PC COM port or
establish an infrared connection. If you are prompted to do
so, enter a name for your communicator.
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Shift-click or Ctrl-
click also selects
multiple files or
folders.

If press the Ctrl key
while you drag the
item, the item is
removed from its
original location.

File Transfer Window Panes

The File Transfer screen looks very similar to Windows
Explorer. It is divided into two panes that can be re-sized by
dragging the splitter bar that separates them.

Drives and folders for both the Nokia 9110 Communicator and
your PC are listed on the left, and can be expanded by clicking
the + icon. The contents of the drive or folder highlighted on the
left are shown on the right side of the window.

Selecting Files

Standard Windows file selection methods are used to select files
or folders in the File Transfer screen. You can select an item by
clicking on it with your mouse, or using the up and down arrow
keys on your keyboard.

Use the Shift key in combination with the up and down arrow
keys to select multiple adjacent items.

Copying Files and Folders

Files and folders can be copied in the File Transfer window
using “drag and drop” or by copying and pasting.

To Drag and Drop:

1. Inthe left pane, highlight the drive or folder containing the
item you want to copy.

2. Incither pane, select the item(s) you want to copy.

3. Hold the left mouse button down, and drag the item(s) to
the new location. A + next to the cursor shows that you're
copying (and not cutting) the item.

4. Release the mouse button.
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Keyboard Shortcuts:
Ctrl-C = Copy
Ctrl-V = Paste

Note that the use of the
Ctrl key in drag and
drop operations is not
identical to its use in
Microsoft Explorer.

You cannot cut read-only
files or root folders from
the communicator.
Cut/Paste operations for
these files/folders are, in
effect, Copy/Paste
operations.

Keyboard Shortcuts:

To Copy and Paste:

1. In the left pane, highlight the drive or folder containing the
item you want to copy.

N

In either pane, select the item(s) you want to copy.

3. Select Copy from the Edit menu, or click the right-mouse
button choose Copy from the pop-up menu.

4. Highlight the left-pane drive or folder to which you want to
copy the file.

5. Select Paste from the Edit menu, or click the right-mouse
button and choose Paste from the pop-up menu.

Moving Files and Folders

Files and folders can be moved in the File Transfer window
using “drag and drop” or by cutting and pasting.

To Drag and Drop:

Use same drag and drop technique described previously for
copying. However, you must press the Ctrl key while dragging.
If you do not, the file or folder will not be removed from its
original location.

To Cut and Paste:

1. In the left pane, highlight the drive or folder containing the
item you want to cut.

2. In either pane, select the item (or items) you want to cut

3. Select Cut from the Edit menu, or click the right-mouse
button choose Cut from the pop-up menu.

4. Highlight the left-pane drive or folder to which you want to
move the file or folder.

Ctrl-X = Copy

Ctrl-V = Paste 5. Select Paste from the Edit menu, or click the right-mouse
button and choose Paste from the pop-up menu.
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Multiple items
can be deleted at
once in the right
pane. Only one
item at a time
can be deleted
from the left
pane.

Deleting Files and Folders

There are three ways to delete an item from the left or right
pane of the File Transfer window:

Select the item you want to delete. Then:
¢ Press the Del key
¢ Sclect Delete from the Edit menu, or

¢ Press the right mouse button and choose Delete from the
pop-up menu.

Note: You cannot delete root folders or read-only files from the
communicator.

Items deleted from your PC are sent to the Windows Recycle
bin.

Renaming Files and Folders

Just like in Windows Explorer, you can rename files and folders
using the Rename command.

To rename a file or folder:
1. Select the file or folder you want to rename in either pane.

2. Select Rename from the File menu, or click the right-
mouse button and choose Rename from the pop-up menu.

3. Type a new name and then press Enter.

Note: You cannot rename non-empty folders, root folders, or
read-only files in the communicator.
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File Properties

Like Windows Explorer, the PC Suite File Transfer function

3,

lets you display and edit a file or folder’s “properties.”
Follow these steps:
1. Select a file or folder in either pane.

2. Select Properties from the File menu, or click the right-
mouse button and choose Properties from the pop-up
menu. This displays the Properties dialogue.

When a Properties
dialogue is displayed
for a communicator
file or folder, check
boxes are disabled
(greyed). You cannot
change the attributes
of a file or folder in
the communicator.

Check or un-check the check boxes in this dialogue to change a
PC file or folder’s attributes.

¢ C(Click OK to save changes and exit the dialogue.
¢ Click Cancel to exit without saving changes.

+ Click Apply to save changes without exiting.
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File Transfer Menu Commands

TILE

Exit

Exits PC Suite.

Status Bar

Toggles status bar on and off.

Large Icons

Switches view to Large Icons mode.

Small Icons

Switches view to Small |con mode.

List

Switches view to List mode.

Details

Switches view to Details mode.

Arrange Icons

Lets you arrange icons by Name, Type,
Sze, or Date.

Refresh Refreshes (updates) display.

Cut Cuts the selected file or folder.

Copy Copies the selected file or folder.

Paste Pastes the itemthat was cut or copied
to the selected location.

Select All Selects all the items in the open folder.

Invert Selection Inverts the selection status of each file
in the open folder.
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COMPONENTS

Contacts

Starts Contacts application component.

Intellisync

Accesses | ntellisync component.

File Transfer

Accesses File Transfer component.

Backup/Restore Accesses Backup/Restore component.
Install/Remove Accesses | nstall/Remove component.
Import/Export Accesses | mport/Export component.
HELP

Contents Displays on-line Help Contents.
Commands Displays command information.
Using Help Accesses Help for on-line Help.
About PC Suite Displays “ About PC Suite’ dialogue.
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Chapter 5 : Backup and Restore

This chapter discusses the PC Quite Backup and
Restore commands, which safeguard the data in
your communicator.

Topics include:
¢ Backing Up Your Data
¢ Restoring a Backup

¢ Backup/Restore Menu Commands
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The Selected device
data option does not
backup settings and
add-on applications.

Using the Browse
button to specify the
Backup path prevents
you from making
typographical errors.

The Backup dialogue contains check boxes labelled All device
data, Selected device data, and Memory card data.

All device data, when checked, backs up Calendar and
Contact data, documents, settings, and add-on applications.

Selected device data, when checked, enables three
additional check boxes. You can select any or all of these
options.

Calendar data: Backs up your Calendar data, including
both Calendar and To do list records.

Contact: Backs up Contact records.
Documents: Backs up communicator documents.

Memory card data: Lets you include data in your Nokia
9110 Communicator Memory Card in the backup. If you do
not check this option, Memory Card data is excluded from
the backup.

Using the check boxes in the Backup dialogue, specify the
data to backup.

In the box labelled Backup Path, specify the location (path)
where you want backups stored. The backup name,
Nokia9110Backup, is assigned automatically.
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Number of Backup Stores

The PC Suite Backup command creates multiple. sequentially
numbered backups—¢.g.. Nokia9110Backup0O1,
Nokia9110Backup02, Nokia9110Backup03, and so on.

Nokia9110Backup01 is always the most recent backup.

The maximum number of backups stored is determined by the
value entered in the box labelled Number of backup stores. The
default value is 3. You can enter any number between | and 99.

Note: If you change this number before creating a new backup.
existing backups will be deleted if the number you enter is less
than number of existing backups. For example, if you have 10
existing backups. and you change the number to 3. the five oldest
backups will be deleted when you create the new backup.

5. Enter a number between land 99 in the box labelled
Number of backup stores.

6. Click the Backup button to execute the Backup operation.

If you’re using a desk stand with your communicator, refer to
Desk Stand Button Settings, in Chapter 1, for information on
how you can program your desk stand button to run the currently
configured Backup operation.
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Restoring a Backup

Follow these steps to restore a backup to your communicator:

1. Start PC Suite and click the Backup/Restore icon. Then
click the Restore tab in the opening screen.

2. Connect your communicator to your PC COM port or
establish an infrared connection.

A single Restore
operation can restore
an entire backup (e.g.,
Nokia9110Backup 01)
or one backup
component (e.g.,
Contacts).

When there is no active
connection between
your communicator and
PC, the Restore button
is disabled in the
Restore tab.
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The Restore dialogue lists all the backups in the specified
Backup directory. Nokia9110BackupO1 is always the most recent
backup in the specified location.

3. If necessary, specify the location of the backup in the text
box labelled Backup store. (The location of the last-created
backup is entered by default.)

4. In the lower portion of the dialogue, click on the data you
want to restore.

You can select an entire backup (e.g., Nokia9110Backup01),
or one component of a backup (e.g., Contacts). If you want to
restore more than one component, but not the entire backup,

you’ll need to run multiple Restore operations.

5. Click Restore to restore the backup to your communicator
and exit the Restore dialogue.

Note: If you want to delete a backup or backups, you can do so
in Windows Explorer or in the PC Suite File Transfer dialogue.

Refer to “File Transfer Functions™ in this chapter for
information about PC Suite File Transfer functions.
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Backup/Restore Menu Commands

TILE
Exit Exits PC Suite |

Status Bar Toggles status bar on and off. |
COMPONENTS

Contacts Sarts Contacts application component.
Intellisync Accesses | ntellisync component.

File Transfer Accesses File Transfer component.
Backup/Restore Accesses Backup/Restore component.
Install/Remove Accesses | nstall/Remove component.
Import/Export Accesses | mport/Export component.

OPHONS

Desk Stand Button Displays desk stand button options.
Settings

Registered Lists the communicators that have
Communicators been connected and named.
Preferences Displays the Preferences dialogue.
HELP

Contents Displays on-line Help Contents.
Commands Displays command information.
Using Help Accesses Help for on-line Help.
About PC Suite Displays “ About PC Suite’ dialogue.
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Chapter 6 : Installing and Removing Software

PC Quite's Install/Remove Software function lets
you install software to and remove software from
your Nokia 9110 Communicator’ s main memory or
memory card.

Topics include:

¢ Installing Software on your Communicator
¢ Removing Software from your Communicator

¢ Install/Remove Menu commands
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Installing Software to your Communicator

Follow these steps to install a software package to your
communicator:;

1.

Start PC Suite and click the Install/Remove icon in the
opening screen.

Connect your communicator to your PC COM portt or
establish an infrared connection.

If prompted to do so, enter a name for your communicator.

In the Select Path text box, enter the path (location) of the
software you want to install. Use the Browse button to
quickly locate the software.

Click on the software you want to install in the box below.

In the Install Location box, select Communicator’s
memory or Memory card to specify where you want the
software installed.

Click the Install button.
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Install/Remove Menu Commands

HLE

Exit Exits PC Suite.

Status Bar Toggles status bar on and off.
COMPONENTS

Contacts Starts Contacts application component.
Intellisync Accesses | ntellisync component.

File Transfer

Accesses File Transfer component.

Backup/Restore Accesses Backup/Restore component.
Install/Remove Accesses | nstall/Remove component.
Import/Export Accesses | mport/Export component.
OPTIONS

Desk Stand Button Displays desk stand button options.
Settings

Registered Lists the communicators that have
Communicators been connected and named.
Preferences Displays the Preferences dialogue.
HELP

Contents Displays on-line Help Contents.
Commands Displays command information.
Using Help Accesses Help for on-line Help.
About PC Suite Displays “ About PC Suite’ dialogue.

Page 104

Verizon Wireless
Exhibit 1082-0358



Importing and Exporting Calendar and Contacts Files

Chapter 7 : Importing and Exporting
Calendar and Contacts Files

The PC Quite Import/Export operations can be used
to transfer Calendar and Contacts files between
your Nokia 9110 Communicator and your PC.

Topics in this chapter include:

*

*

2

The Import/Export Commands

Exporting a Calendar or Contacts File to your PC
Importing a File from your PC to your Communicator
Importing a Contacts File

Import/Export Menu Commands
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The Import/Export Commands

The File Transfer The PC Suite Import/Export operations transfer Calendar and
functions described in Contacts files between your communicator and your PC.

Chapter 4 cannot be
used to transfer
Calendar and
Contacts files between
your two system.

Tip: Communicator Contacts files are compatible, field-for-field,
with the Contacts application that is included in PC Suite for
Nokia 9110 Communicator. This Import/Export feature is useful
as a means of transferring Contacts files between your Nokia
9110 Communicator and PC Contacts application.

File Import/Export vs. Intellisync Import/Export

Refer to Chapter 1 for
information on using
the Contacts
application.

It’s important to note how the Import and Export capabilitics
described here are distinct from the Intellisync Import and
Export capabilities described in Chapter 3’s “Importing and
Exporting Data” (Under “Intellisync Special Topics”).

Intellisync Import and Export operations transfer field-level data
between your communicator and PC. Source records are merged
with existing records, and “conflict resolution” is applied when
both systems have similar but conflicting data.

PC Suite’s File Import/Export functions transfer entire files
between yvour two systems. With one exception (sec Importing a
Contacts File later in this chapter), there is no merging of
records or comparison of fields.
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Exporting a Calendar or Contacts File to your PC

Before performing an
export, be sure to
read “Import/Export
vs. Intellisync
Import/Export” at the
beginning of this
chapter.

The PC Suite Export function exports Calendar and Contacts
files from your communicator to ASCII (.txt) files on your PC.

Contacts files created by this function are compatible with the PC
Suite Contacts application. Both Calendar and Contacts files can
be read or edited using any text editor.

Follow these steps to export a Calendar or Contacts file from
your Nokia 9110 Communicator to your PC.

1. Start PC Suite and click the Import/Export icon in the
opening screen.

2. Connect your communicator to your PC COM port or
establish an infrared connection.

If you are prompted to do so, enter a name for your
communicator.

3. Click the Export tab.
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To avoid making
typographical errors,
click the Browse button
and use the file browser
to specify file paths.

Choose one of three options: Calendar data; Contacts;
Contacts File on Memory Card.

If you choose the last option, specify the path (location) of
the Memory Card Contacts database you want to export.

In the text box labelled Select the PC file to create,
specify the name and path of the PC file you will create. (If
you name an existing file, that file is overwritten when you
run the Export.)

Click the Export button to start the operation.
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Importing a Calendar or Contacts File from your
PC to your Communicator

Follow the steps below to import a .txt file to the Calendar or
Contacts application on your Nokia 9110 Communicator.

Note: Before performing an import, read “Importing a Contacts
File.” which follows.

1. Start PC Suite and click the Import/Export icon in the
opening screen to display the Import tab.

2. Connect your communicator to your PC COM port or
establish an infrared connection.

If prompted to do so, enter a name for your communicator.

This function is
primarily useful as a
means of transferring
Contacts application
records to your
communicator.

w

Choose one of three options: Calendar; Contacts; Contacts
File on Memory Card.

Page 109

Verizon Wireless
Exhibit 1082-0363



PC Suite for Nokia 9110 Communicator

This Import function
yields the same result
as the Contacts
application’s Update to
Communicator
command.

+ If you select Calendar, the file you specify replaces the
Calendar file in your communicator’s main memory.

+ Ifyou select Contacts, the existing Contacts file is
updated with records from your PC file.

+ If you select Contacts File on Memory Card, you must
specify a memory card filename. If you name an
existing file, the file is updated with records from your
PC file.

4. Specify the PC file that you want to transfer to your
communicator. To avoid making typographical errors, click
the Browse button and use the file browser to select the
file.

5. Click the Import button to start the operation.

Importing a Contacts File

The Import function, when applied to a Contacts file, merges
records from a PC Contacts file into the existing Contacts file
in your communicator.

During the merging process, records in your two systems are
compared, and records that exist in your PC Contacts file that
do not exist in your communicator are transferred to your
communicator.

Note that if a record in your PC Contacts file is almost, but not
quite identical to a record in your communicator, the record is
transferred. This means, for example, that if each of your
systems has a Contact card for John Johansen, but the phone
numbers in the two cards are different, a duplicate card
(containing a different phone number) is created in your
communicator.

If you want to synchronise the Contact records in your two
systems and avoid the possibility of creating “duplicate” records
containing conflicting data, use the Intellisync synchronisation
function described in Chapter 3.
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Import/Export Menu Commands

TILE

Exit

Exits PC Suite.

Status Bar

Toggles status bar on and off. |

COMPONENTS

Contacts

Sarts Contacts application component.

Intellisync

Accesses | ntellisync component.

File Transfer

Accesses File Transfer component.

Backup/Restore Accesses Backup/Restore component.
Install/Remove Accesses |nstall/Remove component.
Import/Export Accesses | mport/Export component.
OP HHONS

Desk Stand Button Displays desk stand button options.
Settings

Registered Lists the communicators that have
Communicators been connected and named.
Preferences Displays the Preferences dialogue.
HELP

Contents Displays on-line Help Contents.
Commands Displays command information.
Using Help Accesses Help for on-line Help.
About PC Suite Displays “About PC Suite” dialogue.
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Index

B

Backup Dialogue, 95
Backup/Restore Icon, 7

C

Choose Translator Dialogue
Apply to all applications
checkbox, 39
Communications Port
Setting, 8
Contacts Application
adding contact cards to, 16
adding pictures to Contact
cards, 20
and updating
communicator records,
27
Card menu commands, 16
creating a card template,
15
creating and editing
contact groups, 21
editing contact card fields,
17
editing contact cards, 17
finding a contact, 22
main screen, 14
opening a database, 15
saving a database, 15
Contacts Icon, 7

D

Desk Stand Button Settings,
11

E

Exporting Data From Your
Communicator, 70

F

File Tab, 36
File Transfer Functions, 86
copying files and folders,
87
deleting files and folders,
89
moving files and folders,
88
properties, 90
renaming files and folders,
89
selecting files, 87
File Transfer Icon, 7
File Transfer Window Panes,
87
First-Run Synchronisation,
79
Full Re-Synchronisation, 80

I

Icons

help, 5

PC Suite, 5

readme, 5

uninstall, 5
Import/Export Icon, 7
Importing Data to Your

Communicator, 70
Install/Remove Icon, 7
Intellisync

and Freeform Fields, 67
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Intellisync, 33

Additional Details
Dialogue, 49

address formats, 35, 67

Advanced Button, 39

Advanced Settings
dialogues, 42

and data truncation, 63, 71

Choose Translator
dialogue, 36

Conditions Tab, 56

Configuration Dialogue,
36, 38

Confirmation Prompt, 46,
47,48, 72

Conflict Resolution tab,
50

Conflict Resolution, 66,
78

Contflict Resolution
Dialogue Box, 52

Contflict Resolution
Options, 52

data conflict, 50, 78

Date Range, 44

Date Range Tab, 43

Details Dialogue, 48

fanning of repeating items,
79

Field Mapping Dialogue,
61

Filters Tab, 55

First Run
Synchronisations, 40

first-run synchronisation,
79

Full Re-Synchronisation,
72, 80

glossary, 78

history files, 66

how synchronisation
works, 66

Import and Export
operations, 70
Key Fields, 51
letter case in key fields, 51
notes on conflict
resolution, 54
Notity Conflict Resolution
option, 52
Options dialogue, 37
Re-Sync Button, 72
Rules Tab, 57
Same Record Changed and
Deleted Dialogue, 73
Sync Log File, 74
Taskbar Synchronisation,
40
To Do Range, 45
tutorial, 34
Intellisync Advanced Settings
Dialogue
Confirmation tab, 46
Date Range tab, 43
Field Mapping, 61
Filters tab, 55
To-do list tab, 45
Intellisync Buttons
Re-Syne, 72
Intellisync Confirm Record
Deletions, 72
Intellisync Contacts
synchronising memory
card Contacts file, 36
Intellisync Data Conflict, 78
Intellisync Field Mapping, 79
asterisks in Field Mapping
dialogue, 63
default mapping, 62
Freeform Fields, 64
mapping non-adjacent
fields, 62
Intellisync files
history files, 66, 80
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sync log, 74
Intellisync Filters

Add to List button, 58

and logical operators, 57

Conditions tab operators,

59

creating, 58

notes, 60

Update Button, 58
Intellisync Filters Tab, 55
Intellisync Glossary, 78
Intellisync History Files, 40,

66, 80
Intellisync Icon, 7
Intellisync Settings

Date Range setting, 43

P

PC Contacts Application
JPEG files, 41
Preferences Dialogue, 8, 12

R

Readme File, 5
Remote Synchronisation
vs. local synchronisation,
76
Restoring Backups, 97

S

Sync Log File, 74
Synchronisation
and data truncation, 71
first-run, 79
Same Record Changed and
Deleted, 73
System Requirements, 3

T

Translator, 81

U

Intellisync Field Mapping, 62
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